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Preface

The primary objective of this textbook is to provide a solid introduction to the Pascal
language for individuals using a Macintosh® System. The authors believe that either
THINK Pascal® or Macintosh Pascal® can provide a stimulating environment for learning
programming. These languages provide a combination of power, unique graphics
qualities, and translators, providing easy access to the Macintosh's capabilities.

This book has been written to serve as both a useful introductory reference book and
a self-study guide. As a textbook, it is directed toward the beginning courses on Pascal for
computer science programs as well as special-interest courses on Pascal for Macintosh
users. The level is elementary for Chapters 1 through 8, but shifts to intermediate in
Chapters 9 through 14. An appendix is included for readers who want an introduction to
SANE libraries. This book includes all the usual topics of a beginning textbook on the
Pascal language, plus topics on both Macintosh and THINK Pascal that are special to the
Macintosh computer. Topics included are pointers, abstract data types (ADT), files, string
manipulation, procedures supported by both the QuickDraw and SANE libraries,
programmer-defined units and programmer-defined libraries, profiling, the LightsBug
debugger, and object-oriented programming.

This text reviews botb THINK and Macintosh Pascal. For those who want to
program in THINK Pascal, this edition includes three new chapters: 2, 8, and 13. Chapter
2 reviews using the THINK Pascal environment for building a project and implementing
a Pascal program. Chapter 8 provides further applications of projects by discussing the
implementation of program units and program libraries. In Chapter 8 we discuss the
LightsBug debugger and examine the capability of THINK Pascal to profile the execution
of a THINK Pascal program. Chapter 13 introduces object-oriented programming, an
extension to standard Pascal. Chapters pertinent to readers using Macintosh Pascal are 1,
3-7, 9-12, and 14. Throughout the textbook, comments are given where Macintosh and
THINK Pascal are different. Where relevant, a section has been included in some of the
chapters comparing Standard Pascal with both THINK and Macintosh Pascal.

XV



Preface

xvi

To use this book as a self-study guide, we suggest the following steps. First, read the
chapter objectives and review questions before reading the first section of any chapter.
Second, when you have completed reading a section within a chapter, return to the review
questions, and see if you can answer any of them. Third, enter the examples in each
section that are full programs, and see if they will execute. If you have any syntax or
execution errors, check the program listing and make corrections. If you are successful at
executing the example, try to modify it to perform one or more other actions, again
testing your program to see if it will execute. After completing a chapter, again read the
review questions. Once you feel that you have answered those questions correctly, choose
several programming examples from the chapter, so that you can try to improve your
ability to write THINK or Macintosh Pascal programs. Note that some of the programs
listed in this book may appear different from a listing in the program window of the
Macintosh computer. This was done so that the programs could be read more easily.

The Macintosh system is a true graphics machine. A person using either THINK or
Macintosh Pascal can write computer programs in a high-level language that is able to
interact with the ROM-based graphics capabilities of the Macintosh system. For example,
a student in computer science using the Macintosh system and either THINK or
Macintosh Pascal has a tool for understanding some of the basic graphics routines required
of a workstation. By applying the QuickDraw Library routines, you can overlay several
windows on the screen, only one of them being active at any time. In any active window,
you can draw lines, curves, regions, pictures, polygons, or text, with control limited to
actions of the mouse. Under System 7, Pascal programs written in THINK Pascal can be
transformed into separate applications and executed simultaneously.

Each chapter introduces the basic principles of Pascal by defining the syntax, and
through the presentation of complete THINK or Macintosh Pascal programs, shows the
semantic actions. Having full Pascal programs allows you to enter the programs into a
Macintosh system and observe the results of execution. You are not only able to verify
the discussion in each chapter, but you can alter the example to test your own ideas. This
reinforces learning of the material and builds self-confidence. As you enter a program, you
can immediately correct errors and observe the results. All chapters include programming
exercises in addition to the complete examples, providing practice with the material
presented. Altogether there are more than 660 review questions and more than 240
programming exercises, which range in difficulty from simple to challenging. Stepwise
refinement is applied in the development of all structured algorithms and programs.
Throughout the book, structured programming concepts are stressed, and the later chapters
employ structure charts to enable effective top-down programming design. Chapter 13
introduces a new way of thinking and programming: object-oriented programming.

We have chosen to write this book using THINK Pascal 4.0 and Macintosh Pascal
3.0, both published by THINK Technologies. While Macintosh Pascal is an interpreted
version of Pascal, THINK Pascal is a full compiler. Both translators allow the use of
windows for editing and composing programs, making either translator an excellent
teaching language. In most instances, programs written in Macintosh Pascal are upward-
compatible to THINK Pascal. While other compilers exist for writing Pascal programs,
both THINK and Macintosh Pascal provide a simpler desk-top environment for editing
and composing projects. All THINK and Macintosh Pascal programs in this text have
been executed on Macintosh machines such as SE-30, Ilcx, IIci, and IlIsi, under either
System 6.05, 7.0, 7.01, or 7.1. When using System 7, the authors recommend that
Macintosh Pascal be executed only under 24-bit addressing with virtual memory turned
off. To redefine these options, first double click on Control Panels from the Apple
menu. This opens the Control Panels folder. Now, double click on the icon labeled
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Memory. This opens the following dialog window for setting options such as cache size,
virtual memory, and 32-bit addressing.

EO==———-= Memory

Disk Cache Cache Size

Always On

Select Hard Disk:

Virtual Memory = UW's HD v
oL Available on disk: 161M
— O off Available built-in memory: 20M

3]

32-Bit Addressing

8 @o
Q ot
Use Defaults
v7.0.1

To turn off Virtual Memory and 32-bit addressing, click the Off buttons shown above.

With this dialog window open, click the Virtual Memory button to Off to turn off
the virtual memory option, and click the 32-bit Addressing mode to Off to run the
Macintosh system in 24-bit mode. On closing this window and on returning to the
desktop, choose Restart from the Special menu. These changes take effect when the
Macintosh machine restarts. While Macintosh Pascal can conveniently be executed from a
floppy disk, the authors recommend that THINK Pascal be executed from a hard-disk drive
with a minimum storage capacity of 20 megabytes on a Macintosh machine with at least
2 megabytes of RAM (4 megabytes if you are using the THINK Class Library) if you are
using System 7. The complete THINK Pascal system requires 5.75 megabytes of disk
space.

To help the reader distinguish special terms, we sometimes use a different font for
them. For example, we use the Courier font for identifiers and the Chicago font for
menu items. Programs and algorithms are shown in the Courier font.

Many of the figures in the text (including the one above) present what is called a
screen dump: a printed representation of what actually appears on the screen. In screen
dumps, the fonts used by the computer appear in the figure. Often these are the Geneva
font, the Monaco font, or the Chicago font. Where special font styles occur in screen
dumps, we have attempted to preserve them. In some cases, type will appear in an inverse
mode: white type on a black background. In other cases, fonts will appear to be dimmed
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(gray, rather than black). In a dialog box, a dimmed font indicates that a given feature is
not available under the current conditions. In a few cases, fonts will appear in hollow
outline form. In the Edit windows of the Pascal software, this indicates a problem with
the program line. In Pascal programs, bold is used to indicate reserved words such as
begin and end. These variations are illustrated below.

Some typical style variations in screen dumps

Inverse Type Bold Type

Hollow Type Dimmed Type

We wish to acknowledge the help of several people who contributed to this project.
First we wish to thank Dr. Marijo LeVan and Dr. Jerry LeVan for contributing ideas for
examples as well as comments. We wish to thank Phyllis Gabbard, Suzanne Tipton, Lisa
Rains, Pauline Coleman, and Kellie Lynn for their help in the preparation of the first
edition of the manuscript. We would also like to thank the following reviewers of the
first edition of this textbook: Herman Gollwitzer of Drexel University, Barry S. Marx of
Wake Technical College, Denise Kiser of the University of California at Berkeley, Henry
Etlinger of Rochester Institute of Technology, Christine Kay of DeVry Institute of
Technology, and John Fleming, production editor with Prentice Hall, for the helpful
suggestions they made in the preparation of the first edition.

In completing the second edition, we extend our appreciation to Marcia J. Horton,
Editor-in-Chief, Prentice Hall/College Technical Division for her time and patience with
us. We also extend our appreciation to Mona Pompili, our production editor, and
Nicholas Murray, our copy editor.

Macintosh is a trademark licensed to Apple Computer, Inc.; THINK and Macintosh
Pascal are products of Symantec Corporation (THINK Technologies, Inc.); WORD,
Excel, and Multiplan are products of Microsoft, Inc.; Jazz is a product of Lotus
Development Corporation; TML Pascal is a product of TML systems; and Turbo Pascal
is a registered trademark of Borland International, Inc. SuperPaint is copyrighted by
Silicon Beach Software, Inc. Sum II is a product of Micro Analyst, Inc. MacPaint and
MacWrite are registered trademarks of the Claris Corporation.



Chapter 1

Introduction to Macintosh
Pascal

OBJECTIVES

After completing Chapter 1, you will know the following:
1. What is meant by the terms computer and computer program.
2. The nature of the Macintosh Pascal windows and menus.
3. How a computer program is built and edited with Macintosh Pascal.
4. How to check, edit, execute, save, and print a Macintosh Pascal Program.

1.1 COMPUTERS AND COMPUTER PROGRAMMING

A computer is an automated machine that can process information and, in doing so, solve
one or more problems. What type of information can a computer process? This usually
depends on the type of problem to be solved and who is using the computer. For
example, an engineer may use a computer to solve a mathematical problem, in which
case the solution is a mathematical model of an engineering process. A business
executive may use a computer to provide information on sales, gross profits, costs, and
projected future profits and sales, with the computer providing information in both tabular
and graphic formats. A student may use a computer to link with a database located
thousands of miles away and submit questions to retrieve factual and deduced information
from some set of information. In all these examples, the information to be processed by
the computer may be numeric data (numbers) or symbolic data (characters) representing
processes taking place at a particular instant of time.
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When the computer is being used to solve a problem, the format or the steps
necessary for solving the problem have previously been entered into the computer by
means of a computer program. The word processor used for composing these paragraphs
and printing each character, word, line, and paragraph of text, is a computer program. A
computer program is also information to the computer, but information of a special type.
We will define a computer program as an ordered set of instructions written in an artificial
language (such as Macintosh Pascal or THINK Pascal). The instructions composing the
computer program represent the solution to a problem. Computer languages are often
referred to as artificial languages because they are more restrictive in the application of
syntax (grammar) and semantic (meanings) rules, attempting to avoid the ambiguity
found in natural languages. Another reason for the term artificial is the origin of these
languages in a laboratory environment. Although at present Pascal may appear to be an
extensive language, you will soon see that it is much simpler to understand than any of
the natural languages such as English, German, French, or Russian. It is a highly
structured language with specific syntax rules and semantic definitions for each of its
commands. It is best if you begin by learning some of the easier syntax rules for compos-
ing data objects (nouns in Pascal), commands that provide action (sometimes referred to
as verbs), and the rules necessary to form acceptable sentences that provide semantic
meaning to the computer program.

A computer language allows an individual to communicate the solution to a problem
to a computer. Why is this so important? First, computers like the Macintosh execute at
a very primitive level, a machine level where all commands and information are binary.
This means that they are composed of sequences of 1 and O bits. Writing programs at the
machine level is possible, but only if the programmer has a thorough knowledge of the
machine being used, has extensive programming experience, and pays considerable
attention to the storage of information at specific locations (addresses) in the memory of
the computer. An understanding of how basic operations are to be performed is also
needed. Using a high-level language such as Pascal frees the programmer from such
concerns and allows concentration on defining the steps for solving the problem. The
binary machine instructions are generated when the Pascal program is compiled by the
computer.

1.2 BASIC COMPUTER ORGANIZATION AND THE MACINTOSH

When describing a computer, it is useful to consider its basic organization from the
viewpoint of input, output, memory, and execution. The Macintosh computer can be
viewed as a von Neumann machine, named for the mathematician John von Neumann,
who is credited with the stored-program concept of computing. As shown in Figure 1.1, a
computer has five basic units: the central processor, memory, input, output, and the bus.

In a von Neumann machine, the function of the central processing unit (CPU) is to
fetch an instruction of a computer program from main memory, decode this instruction,
and then execute it; this same process is then repeated. During the execution of an
instruction, the CPU is capable of performing basic arithmetic operations such as
addition, subtraction, multiplication, and division; basic logical operations, such as a
comparison of values; and the merging and masking of data. The CPU is also capable of
controlling the actions of other units, such as memory, input, and output. For the
Macintosh, the central processor is the MC68040 microprocessor, the MC68030
microprocessor, the MC68020 microprocessor, or the MC68000 microprocessor. In some
Macintoshes there is also a co-processor, the MC68881/882.
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Figure 1.1 Basic organization of a computer.

Memory is divided into two distinct classes: primary, or main, memory and
secondary memory for storage. The purpose of main memory is to store programs for
performing one or more specific functions, as well as the data needed when a program is
executed. For example, the word processing program used for writing this paragraph,
Microsoft WORD, is contained in main memory along with the text as it is entered from
the keyboard. Having both the program and data in main memory provides for fast
response when entering additional words or making corrections to text previously entered.
In the Macintosh computer, main memory is divided into two basic structures: random-
access memory (RAM), and read-only memory (ROM). RAM offers flexibility, since it
can both be written to and read from as long as the Macintosh remains powered. Once the
Macintosh is turned off, any information stored in RAM is lost. ROM contains
information needed by the Macintosh to "boot," or start up, when the power is turned on
and also provides numerous instructions for interfacing with RAM memory, disk drives,
the printer, windows, and menus. ROM is different from RAM in that it can be read from
but not written to by the program being executed. ROM is also permanent; its contents
do not vanish when the Macintosh is turned off.

Main memory can be viewed as a large, one-dimensional table of cells, each cell
storing 1 byte of information. As Figures 1.2 and 1.3 show, each cell has a unique
address represented by a whole number. Figure 1.2 was created with the software SUM II
“SUM Tools,” which allows the Macintosh user to map the memory of the Macintosh.
Note the location of the word processing software (which takes up 1000 K, or 20% of the
available RAM for this particular configuration).

The byte is composed of 8 individual bits, single binary digits, with each bit location
containing either a O or a 1. Whereas humans are accustomed to communicating in natural
languages, computers deal with a more fundamental level of information where all
characters are represented by 1 and 0 bits. An individual character shown on the keyboard
of the Macintosh can be stored in a byte location of memory.
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$500000 Top of Memory
Applications
- oftware
$001E00 System Zone
$000000 Bottom of Memory

Figure 1.2 Representation of main memory for a Macintosh
SE/30 computer with 5 megabytes of RAM.

By having a program that is capable of linking several bytes together, complex data
such as alphabetic characters, numbers, or structures containing several different types of
data can be stored. An example of the storage of an alphabetic character is shown in
Figure 1.3.

Since RAM will lose the information stored in it after the Macintosh is turned off,
secondary memory provides backup storage for programs and data. In the Macintosh,
secondary memory is provided by a magnetic disk medium, such as a floppy diskette or
hard disk. By inserting a properly formatted diskette into a disk drive, you can store
information or retrieve information from what is referred to as a file. A file represents a
collection of information stored on a diskette, analogous to the concept of storing a file of
papers in a file cabinet. A file can be an application program, such as the Macintosh
Pascal interpreter or the THINK Pascal compiler, a text document, a paint document, an
application such as the Finder from the System Folder, and so forth. When the
Macintosh's power is off, data that has been stored on a floppy diskette is not lost. This
is one of the major advantages of secondary memory over primary memory.

Several different types of 3 1/2-inch floppy disk drives are used in the Macintosh. For
the oldest Macintosh machines (128K and 512K), disk drives were limited to a maximum
storage of 400K (409,600) bytes. The next group of Macintosh machines (Macintosh
Plus and Macintosh SE) used floppy disk drives with 800K (819,200) bytes of storage
capacity. The newer Macintoshes, beginning with the SE/30, use the “super drives” or
“FDHD” drives which store 1.44M (1440K or 1,474,560) bytes. Hard disk drives, with
the disks permanently encased, can provide 20 megabytes (the prefix mega means
"million"), 40 megabytes, 80 megabytes, or more disk space. Hard disk drives provide
faster access to the contents of files than the 3 1/2-inch floppy disk drives.
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An input unit provides a means to communicate with the computer. For the
Macintosh, both the keyboard and the mouse are input devices. The keyboard allows us to
enter information such as text in a word processing document, while by clicking the
mouse button, we can enter information such as our choice of options from a menu bar.

The output unit allows the computer to communicate with the user. In the case of
the Macintosh, the screen is an output device. Another output device is a printer, such as
a laser printer or a dot matrix printer. A disk drive can also serve as both an input and an

output device.
$500000 Top of Memory
Bit Positions
76543210
01000001
—Y_—l
This memory cell Byte
;tores the chra;;'la:‘cttilr1 yt
'A’, represented by the
binary pattern —>
01000001
$000000 Bottom of Memory

Figure 1.3 Representation of a single byte in the main memory
of a Macintosh computer.

The bus provides an electrical path for connecting these components. Both commands
and information can be passed along this path. In the Macintosh there are two types of
bus structures, internal and external. The internal bus links the central processor with
main memory, while the external bus provides a link between main memory and
secondary memory as well as other input and output devices.

1.3 USING THE MENUS ON YOUR MACINTOSH PASCAL DISK

We assume that you are familiar with the general operation of the Macintosh and with its
associated terminology. If you are not, read the manual that came with your Macintosh,
or its equivalent, before continuing. To increase your dexterity in using the mouse, you
may want to practice with a word processing application such as MacWrite or WORD and
a painting program such as MacPaint or Super Paint. Once you have become comfortable
with the routine operations of the Macintosh, you are ready to proceed to the Pascal
software. '



Chapter 1 Introduction to Macintosh Pascal

To use Macintosh Pascal, follow the instructions provided with your software to load
Macintosh Pascal onto your hard disk. When this has been done, you will have a
Macintosh Pascal folder similar to the one shown in Figure 1.4. The Macintosh Pascal
software used by the authors and represented in the figure is version 3.0.

Bl

6 items

Hl

4,871K available

MacPascal
34,181K in disk

[

E

Open Mel!

BBEdit

Macintosh Pascal
7N
PShell Information Demos

v
] =

Figure 1.4 The Macintosh Pascal 3.0 folder.

To begin, double-click the Macintosh Pascal icon. After a brief delay, the three
Macintosh Pascal windows shown in Figure 1.5 are displayed. The first of these is called
the Program window, and it is here that your Pascal program is entered, edited, and
displayed. Initially the Program window is labeled Untitled. Notice that when you move
the mouse within this window, the pointer takes on the shape of an I-beam.

& File Edit Search Run Windows

=[] Untitled Text
&y

program Untitled; :

{Your declarations}

begin

{Your program statements} Drawing
end.

Figure 1.5 The Macintosh Pascal windows and menus.
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This means that you are allowed to insert text. The second window shown on the
screen is called the Text window, and it is here that text output from your program is
displayed. The Drawing window displays graphics output from your program. When you
move the mouse from the Program window to either the Text window or the Drawing
window, the pointer takes the shape of an arrow. Notice that in Figure 1.5 the Program
window has horizontal bars at the top, indicating that it is currently the active window.

The best way to introduce yourself to Macintosh Pascal software is to type a short
program and execute it. Observe that the Program window shown in Figure 1.5 contains a
dark rectangle that includes some inverse print. This template is provided to help you
begin writing your Pascal program. For example, each Pascal program must begin with a
program heading line that has the following form:

program Name;
or
program Name (input, output);

where Name represents the title of the program. The name must begin with a letter,
which can be followed by letters, digits, and/or the underscore character. A name may be
up to 255 characters long (but will usually be considerably shorter than the limit).
Uppercase and lowercase letters in a Macintosh Pascal program name are interpreted as
being equivalent, allowing you to use either or a combination. All of these name rules are
characteristic of what is known in Pascal as an identifier. An identifier serves to label
constants, types, variables, program headings, and other entities that we will encounter
later. Because of this widespread use of the identifier in Pascal, it is to your advantage to
remember these rules.

Returning to our program, first press the Backspace key to clear the Program window
of the dark rectangle. (You may want to take advantage of this pretyped material later, but
for now we will start with a blank window.) Next, type

program Example_la;

You need not worry about the bold print for the word program; it is automatically
added by Macintosh Pascal when you enter your line and press the Return key. In this
example we are using Example_1la as the title for our program. This title conforms to
all of the above rules for naming an identifier. Once you have inserted this line, type a
semicolon to terminate the line of code. You may wonder what happens if a title is
improperly entered. In Figure 1.6 the program title was typed Example. la instead of
Example_1la. Notice that when Macintosh Pascal detects such an error, it displays the
incorrect character and the remaining characters to the right of the error in hollow
outline type.

To continue with our example, type the word begin, and then press the Return
key. The word begin indicates where the program is to begin execution. Next, type the
remainder of the program, as shown below:



8 Chapter 1 Introduction to Macintosh Pascal

program Example_la;
begin

writeln('Sample text output');
end .

& File Edit Search Run Windows
E[(==———= Untitled —V——r=|

program Example
.1a

3

Figure 1.6 A typing error in the name is quickly noted.

Be careful to include all the single quotation marks, periods, and semicolons. In
Pascal these marks are critically important, and failure to pay careful attention to them
can cause undesirable and sometimes strange things to happen to your programs. On the
other hand, you need not be concerned with the indentation or the bold print, since
Macintosh Pascal automatically takes care of these details.

It should be apparent that the only line of this program that actually causes any
action is the third line, which results in the printed message Sample text output
being displayed in the Text window. To verify this, pull down the Run menu, and select
Go. (The Macintosh Pascal menus are shown in Figure 1.5.) The result is the immediate
execution of the program.

If you would like to observe action in the Drawing window, add the command
PaintCircle to your program as shown below:

program Example_la;

begin
writeln('Sample text output');
PaintCircle(100,100,10);

end.

Again, pull down the Run menu and select 60. The result is shown in Figure 1.7. The
third line of the program produces the printed message displayed in the Text window, and
the fourth line causes the circle to be painted in the Drawing window. The numbers in the
PaintCircle statement represent the coordinates of the center of the circle and the
radius of the circle. Try changing these values and the wording enclosed in the single
quotes of the writeln statement. A little experimentation with the programs presented
throughout the text should help convince you of the generality, flexibility, and sheer fun
of the computer program.
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I[C]==——= untitled Texnt

G Sample text output

program Example_1a;
begin
writeln('Sample text output');
PaintCircle(100,100,10);
end.

Drawing

Figure 1.7 The text and graphic output from Example_1la.

1.4 THE PASCAL MENUS
1.4.1 The Run Menu

Figure 1.8 shows the various Macintosh Pascal menus found on the menu bar. Initially
you will be concerned with the Run menu. Using the mouse, move your pointer to the
word Run, click (and hold) the mouse button, causing the Run menu to be displayed.
Keeping the button pressed, drag the pointer down the menu. Notice that the command
options! listed on the menu are highlighted as they are contacted by the pointer. To select
a command option, release the button while that option is highlighted. For example, to
execute a Macintosh Pascal program listed in the Program window, pull down the menu,
and select 60. This command option initiates the execution of the program. Another
useful command option on the Run menu is the Step command. With this option you
can step through a program by executing one line at a time. This feature is useful when
debugging a program, that'is, trying to understand why a program is not properly
executing and where it may be wrong. Select Step from the menu, and then observe that
only the first line of the program is executed. Figure 1.9 shows the result of this first
step. As you can see, a small hand appears in the Program window pointing to the left of
the next executable line of code. Select Step again from the Run menu to execute this
line. Continue this process until all the lines have been executed. If you wish, you can
speed up this process by using the command option Step-Step. This causes the
program lines to be executed in sequence, with a brief delay between each pair of lines.

1 In order to avoid confusion, we generally refer to choices listed on the Macintosh and THINK

Pascal menus as command options.
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| Fie
About Macintosh Pascal... New #N
Calculator Open... *0
Close
Save
Save As...
Find ®F Revert
Replace %R Page Setup...
Everywhere RE Print...
What to find... W Quit 80
Reset Copy 8C Instant
Paste 1)
Go %6 Clear Observe
Go-Go Select AlIl %A Text
Step %S Drawing
Step-Step
Font Control...
Preferences...

Figure 1.8 The Macintosh Pascal menus.

Another command option is Stops In. When this option has been selected, you
may insert a stop to the left of any program line, preventing that line from being
executed. To insert a stop, activate Stops In, move the pointer to the left of a line you
do not wish to be executed, and click the mouse. This causes a stop sign to appear, as
shown in Figure 1.10. By selecting the command option GO, you can execute the
program up to the chosen line. To continue execution of a program after a stop has been
encountered, select 60 again. Figure 1.10 shows the screen after a stop has been inserted
to the left of line 4 in Example_1la. With the stop in this position, execution of the
program will cause the third line to be executed, displaying the message in the Text
window, but leaving the PaintCircle command unexecuted. Selecting the Go option for a
second time will cause the execution of the program to continue from the point where the
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stop appears. In the example, line 4 will be executed, painting the circle in the Drawing
window.

[E[J==——=——=——= Untitled

program Example_1a;
& begin
writeln(‘Sample text output');
PaintCircle(100,100,10);
end.

53

I

Figure 1.9 Stepping through a program.

£l ==——== Example_1la

| (53

program Example_1a;
begin

writeln(‘Sample text output’);
@ PaintCircle(100,100,10);
end.

Figure 1.10 Inserting stops in a program.

Stops can be disabled by selecting the Stops Out command option on the menu.
This leaves all of the stops in place but renders them inoperative and invisible on the
screen. When you select Stops In, the stops are again displayed and again become
operational.

The other command options under the Run menu are Check, Reset, and 6o-G6o.
The command option Check allows you to have the computer check your program for
syntax errors without actual execution. In this mode, each line is examined to determine if
it is a valid Pascal statement. For example, consider the program Example_1la in
Figure 1.11. Notice that the command writeln has been replaced by the word writing.
With this alteration in the program, selection of the command option Check results in
the appearance of a dialog box at the top of the screen, indicating that a bug has been
found in the program. This dialog box with its large bug represents the standard form in
Macintosh Pascal for reporting any error discovered while checking or executing a line of
code. Along with this error message there also appears a hand with its thumb pointing
downward, positioned to the left of the line containing the bug. In the example, the error
results from the illegal command writing. Since Macintosh Pascal will keep you from
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performing any other actions until the dialog box has been closed, you must click
anywhere within the border of the dialog box to close it. Once the dialog window closes,
you are free to correct the error or to perform other command options from the menu bar.

File Edit Search [JiIIJ] windows

QB The name "writing" has not been declared

Untitled
program Example_1a; iy
begin

writing(‘Sample text output');
PaintCircle(100,100,10);
end.

Figure 1.11 Using the Check command option to locate a problem.

The Reset command option allows you to return your program to its initial state.
That is, it is returned to the state it takes prior to execution, clearing the Text and
Drawing windows. You may find the Reset command option useful in connection with
the Step command option. It allows you to return to the beginning of a program without
completing execution of all its lines. In large programs this feature can be a significant
timesaving device. Finally, the 60-60 command option is operational only when the
Stops In command option has been selected. By selecting 60-60 you can step through
a program with only a brief delay at each stop (as compared to a complete halt in
execution). This command option, along with a well-placed set of stops, will allow you
to see your program execute in slow motion.

1.4.2 The Pause Menu

Consider a second program called Example_2, shown in Figure 1.12. Enter this
program as shown, and then select Check to check for any incorrect syntax. If no errors
exist, select 60, and watch the menu bar while the program executes. During execution, a
new menu command appears: Pause. By pointing the arrow at Pause and pressing the
mouse button, you can temporarily halt execution of the program. Releasing the mouse
button while the arrow remains on Pause allows the program to continue execution.
Dragging the arrow down while the pause is in effect will activate the option Halt.
Selection of this option causes execution of the program to stop at whatever line it has
reached. Execution of the program after a halt can continue only by selection of one of the
following command options: Go, Step, or Step-Step. Some Macintosh Pascal
programs cannot or will not end their execution. If this is the case, the option Halt from
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the Pause menu may be the only way to stop execution (short of turning off the
Macintosh).

S =— fyample 2 =——

3

program Example_2;
var
J : integer;
begin
{Display a message 30 times.}
for J:=1to 30do
writeIn('Macintosh Computer');

=<l

Text

Macintosh Computer
Macintosh Computer
Macintosh Computer

_.{

Figure 1.12 The program Example_2 and its output.

1.4.3 The File Menu

To save your Macintosh Pascal program, pull down the File menu, and select Save As....
A dialog box like that shown in Figure 1.13 will appear on the screen. Notice that you
are asked to assign a name to the file. Macintosh file names are extremely flexible, so
you can use almost any name you choose, as long as you can type it in the space
provided in the dialog box. (The Macintosh file system allows a maximum of 31
characters.) Illegal names will be rejected by the computer. You have the option to save
the program as a text file (file of characters as seen on the screen), as an object file (file
stored in machine code), or as an application by clicking on one of the three small
buttons within the dialog box. See Appendix D for more on creating application
programs in Macintosh Pascal.

Once your program has been saved, the name for the file will be displayed at the top
of the Program window. After this, you may use the Save command option to update
your file whenever you make changes in the Program window. It is in your best interest
to select the Save option fairly often when you are writing or editing a program. Once
you have saved your program, you may end your work session by closing your file (select
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Close from the File menu, or click the close box) and then quitting (select Quit from
the File menu).

S Examples

| e Hard Disk

(Corive )

Example_2 Cancel

® As Text QO As Object O As Application

Save your program as

Figure 1.13 Saving a Macintosh Pascal program file.

The Print... and Page Setup... command options of the File menu are used when
you want printed output. These options will be explained in Section 1.5. The New
command option is used to provide an untitled Program window for a new program. If
you select this option when you already have a program in the Program window, the
existing program will automatically be closed when the new untitled window is opened. If
you have changed the existing program since your last file, you will be asked if you want
to save the changes before the window is closed. Finally, Revert allows you to discard
changes made in the Pascal program shown in the Program window and revert to the last
version of the program saved on the disk. ‘

1.44 The Search and Edit Menus

Your Macintosh Pascal program can be edited in the Program window by using the Cut,
Copy, and Paste command options under the Edit menu. To insert text anywhere in
your program, move the I-beam pointer in the Program window to the point at which the
text is to be inserted, click the mouse button to position the pointer, and begin typing.
To remove text, first position the pointer either to the right or to the left of the text.
Then drag the pointer across the text while pressing down on the mouse button. Release
the button when you have highlighted in black the text to be removed. This process is
called selecting the text. Figure 1.14 shows an example of text that has been selected.
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Step 1. Highlight the text to be cut from the Program window.

Program Example_3;
var
J ! integer;
begin

{ Text to be cut and pasted below.}

for J:=1to 30 do
writeln('Next number is ',J);
end.

Step 2. Move this text to the clipboard by selecting the option Cut.

£[ =—=—== Clipboard g—l
{Text to_be cut and pasted below.} ]

Step 3. Move the pointer to where the text is to be inserted, click, and then
select the option Paste.

Program Example_3;
var
J ! integer;
begin

for J:=1to 30do
writeln('Next number is ',J);

{ Text to be cut and pasted below.} /

end.

Figure 1.14 Using the command options Cut, Copy, and
Paste from the Edit menu.

You may remove selected text by pressing the delete key, typing new text, or by
electing the command option Clear or Cut. When the command option Cut is used, the
text that is removed is stored temporarily on the clipboard. Text on the clipboard can then
be moved to another position in the Program window by moving the I-beam pointer to
the point where the material is to be inserted. After clicking the mouse, select the Paste
command option from the Edit menu to paste text that is presently in the clipboard.

The command option Copy is similar to Cut, except that it allows you to copy
selected text to the clipboard without erasing it from the Program window. The Clear



16

Chapter 1 Introduction to Macintosh Pascal

command option allows you to erase text without having it stored in the clipboard. Be
sure you understand an Edit command option before selecting it, since Macintosh Pascal
offers no undo option to quickly correct an error.

The Search menu allows you to search for a pattern of characters and replace it with
another pattern. First select the command option What to find... This brings up a
dialog box like the one shown in Figure 1.15. In the Search for box, type the
characters representing the search pattern. If you want to replace the string you are
hunting, type the replacement characters in the Replace with box.

¢ File Edit BYX:lkdj@ Run Windows

Search for

Replace with

@ Separate Words O All Occurrences |
@ Case Is Irrelevant O Cases Must Match

Figure 1.15 The Search dialog box.

Select the button in the dialog box that is relevant for your search, and if you wish to
continue, click on the OK button. Now move the pointer to the beginning of the program
to indicate where the search will begin. Then choose the command option Find from the
Search menu. Once the pattern is found, searching stops, and the pattern is highlighted.
To replace the pattern with the replacement string, select the command option Replace.
To continue searching, again select the command option Find. To replace a pattern with a
replacement string automatically wherever the pattern occurs, choose the command option
Everywhere. Be careful when using this option however, since it cannot be undone—
there is no undo operation.

1.4.5 The Windows Menu

Three of the options available under the Windows menu have already been discussed: the
Text window, the Drawing window, and the Program window. Figure 1.16 shows these
as well as the other three windows that are available to you. The first of these is the
Instant window. In this window you may enter a single Pascal statement and then execute
it immediately by clicking its Do It button. You may move statements from your
Program window to the Instant window by way of the clipboard. The Observe window
allows you to display the values of selected expressions at critical points in your program
(whenever execution ceases, whether at the end or at a stop you have inserted). This
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feature, along with the Stops In option, allows you to carefully study the execution of
your program. The Clipboard window allows you to view the current contents of the
clipboard.

&€ File Edit Search Run @dows

Untitled Text
I
program Untitled; E[[J=== Clipboard ==}
{Your declarations}
begin
{Your program statements} -
Instant

{Any statements, any time.}

Observe
Enter an expression

Figure 1.16 The Macintosh Pascal windows.

There are two additional options on the Windows menu. The Font Control... op-
tion allows you to select a font and font size for either the Program window or the Text
window. Figure 1.17 shows the dialog box produced when this option is selected. The
other option under the Windows menu will be explained in Section 1.5.

1.5 USING THE PRINTER

You can use your printer to make a paper copy (hard copy) of the material displayed in
any window. For example, if you would like a hard-copy listing of a Pascal program,
activate the Program window, pull down the File menu, and select Print... A dialog box
similar to that shown in Figure 1.182 will offer you the option for choosing the quality
of print, the page range, the number of copies, and paper feed (continuous or cut-sheet).
After you enter this information, the printing will proceed. The Page Setup dialog box,
shown in Figure 1.19, allows you further control over your printed output. This includes
the size of paper, the orientation of the paper. reduction or enlargement, and a variety of

2 The exact nature of this dialog box will vary depending on the printer and the system
software in use.
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other choices. Since both are standard Macintosh dialog boxes, it is not critical that we
discuss every alternative.

By selecting the Preferences... option of the Windows menu, you may direct
the output of your program to the printer as well as the screen. Figure 1.20 shows the
dialog box when this command option is selected. To direct your program to your printer,
click the “Output also to the Printer” box. When the program executes, whatever is
directed to the Text window is also directed to the printer. Notice that this option allows
you to send your output to a file. We will discuss files later in the book.

Set Font and Size:

@® Program Window O Text Window

Geneva

Helvetica
London
Los Angeles

hPEM.lineHeight := (HeaderHeight * 4) + 1;

spaces per tab
2 spaces per indent |
Cancel

Figure 1.17 The Font Control dialog box.

Remember that if you want to change the font of the text being displayed, you must
choose Font Control... to do so.

LaserWriter '"LaserWriter II NT" 5.2
. ance
Cover Page: @NOO First Pageo Last Page E

Paper Source@ Paper Cassette () Manual Feed

Figure 1.18 The Print dialog box.
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LaserlWriter Page Setup 5.2

Paper: (@ US Letter O A4 Letter QO Tabloid
Q US Legal QO BS5 Letter

Reduce or : .
Printer Effects:
Enlarge m % e
g Font Substitution?

Orientation [X] Text Smoothing?

T@ [X] Graphics Smoothing?

X Faster Bitmap Printing?

Figure 1.19 The Page Setup dialog box.

Text Window Output Options:
Text Window saves |gYILIJ1 characters
[]output also to the Printer
[] output also to a File:

Figure 1.20 The Preferences... dialog box.

SUMMARY

In this chapter we have considered the general concept of a computer as an automated
machine. We discussed the basic elements of the computer including input, output,
memory, and the central processor.

We also introduced Macintosh Pascal, including all menus and windows. The
Macintosh Pascal system supports five major menu options: File, Edit, Search, Run,
and Windows. The menu option File supports the selections New, Open, Close,
Save, Save fis..., Revert, Page Setup..., Print..., and Quit. Most of these commands
correspond to the File commands routinely found in other Macintosh applications. The
second menu option, Edit, supports selection of Cut, Copy, Paste, Clear, and
Select RIl. These options allow common cut-and-paste operations for editing lines of
Macintosh Pascal code entered in the Program window. The menu option Search
supports selections of Find, Replace, Everywhere, and What to find...., which are
commands for searching for a string pattern and replacing one or more characters with a
given pattern. Options are available for replacing only the first occurrence or for replacing
all occurrences. The menu option Run provides several alternatives for executing a
Macintosh Pascal program. This includes an option for checking the syntax of a program



20 Chapter 1 Introduction to Macintosh Pascal

without execution by clicking on Check, the option to Reset a program if it has been
halted and is to be executed from the beginning, and execution options such as Go, Go-
Go, Step, and Step-Step. Several options for windows exist through the menu option
Windows . These include selection of the program initially given the title Untitled, an
Instant window for executing Macintosh Pascal commands without writing a Pascal
program, the Observe window for tracing values during execution, the TeXt window for
displaying text, the Drawing window for drawing graphics, the Clipboard for viewing
lines of code cut from the Program Window, Font Control... for controlling the type and
style of font displayed either in the Text window or the Program window, and
Preferences... for directing output from a program to an external file or to a printer.

REVIEW QUESTIONS

1. Write a definition of the term computer.

2. Where have you recently seen computers being used?

3. Define the term computer program.

4. Why is a computer language important in solving problems?

5. What are the five basic units of a computer, and what purpose does each serve?

6. What is meant by the term RAM?

7. What is meant by the term ROM?

8. How can main memory be viewed?

9. What does a byte represent?

10. What is meant by the term secondary memory?

11. Define the term file.

12. What are the advantages of secondary memory?

13. What characters can be used in titling a file?

14. What is the maximum number of characters for a file?

15. How do you rename a file created when using Macintosh Pascal?

16. What three windows are initially shown in Macintosh Pascal?

17. The first line of any Pascal program begins with what command?

18. What is the rule for naming an identifier?

19. What are the six menu options for Macintosh Pascal?

20. What options exist when selecting the Run menu?

21. What options exist when selecting the Edit menu?

22. What options exist when selecting the Window menu?

23. What is the purpose of the Instant window?

24. What is the purpose of the Check option?

25. What is meant by a stop?

26. How can stops be inserted and removed in a source program?

27. What is the purpose of the Observe window?

28. What are the first steps in writing a program?

29. What is the difference between command options Save and Save As... ?

30. How can you edit your program?

31. What is the purpose of the Clipboard?

32. What is the purpose of the Text window? the Drawing window?

33. What is the purpose of the Reset command option?

34. How can a program displayed in the Program window be printed?

35. How can output from a Macintosh Pascal program be directed to a printer?

36. Use the Instant window to see the actions for the following commands. Be
sure you click the mouse button on Do It:
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writeln(45);
writeln('
PaintCircle(

PROGRAMMING EXERCISES

Chapter 1

50,

{ type your own name } ');
45, 45 );
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In the following problems you are given Macintosh Pascal programs that are listed side
by side. Please do not concern yourselves with the Pascal code, since much of what you
see will be discussed in the chapters that follow. The purpose of these programs is to
allow you to experience some of the types of syntax errors that can arise as you type
Pascal code in the Program window. Enter the program on the left. Correct each error as it
arises by looking at the corrected code to the right. Introducing your own errors beyond
those given by a program on the left is highly encouraged.

1. Begin with a new Program window, and enter the program on the left by typing
each line as it appears. If a syntax error appears, correct the error using the
corresponding line from the program on the right. Save the program after it has
been corrected, and then test the program by executing it. Select the GO

command to execute it.

program Problem One(input, output)
{ This program prints your name. }
var
Name : string(30);
begin Body of main program }
ShowText
{ Prompt for name. }
write('Enter your name: );
readln( Name ;
{ Display your name.
writeln("Y our name is Name );
end

program Problem_One(input, output);
{ This program prints your name. }
var
Name : string[30];
begin { Body of main program.}
ShowText;
{ Prompt for name. }
write('Enter your name: ' );
readln(Name);
{ Display your name. }
writeln("Your name is ',Name);
end.

2. Repeat the procedure used in Exercise 1 for this Pascal program.

program Prob_Two(input, output)
{ This program displays 10 numbers. }
uses
QuickDrawl;
var
Counter ; integer :

begin
{ Hide all windows but the }
{ Text Window. }
HideAll;
ShowText
{ Display 10 numbers. }

program Prob_Two(input, output);
{ This program displays 10 numbers. }
uses
QuickDrawl;
var
Counter : integer;

begin
{ Hide all windows but the }
{ Text Window. }
HideAll;
ShowText;
{ Display 10 numbers. }
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for Counter <-- 1 to 10
writeln( Counter );
end.

Chapter 1

for Counter := 1 to 10 do
writeln( Counter );
end.

3. Repeat the steps used in Exercise 1 for the Pascal program that follows.

program Problem_Three(input, output);
{ This program keeps displaying }
{ numbers. Use menu option Pause }
{ to halt execution. }
var
Number ; integer:
begin
ShowText
while true
begin
Number = random;
writeln( Number ' ')
end;
end.

4. If a printer is attached to your Macintosh, what steps are needed to select the
proper menu option and dialog windows for activating printing as numbers are

program Problem_Three(input, output);
{ This program keeps displaying }
{ numbers. Use menu option Pause }
{ to halt execution. }
var
Number : integer;
begin
ShowText;
while true do
begin
Number :=random;
writeln( Number, ' ')
end;
end.

displayed to the Text window. Try this with Exercise 3.

5. Repeat the steps used in Exercise 1 for this Pascal program.

progam Problem_Five(input, output);
{ This program generates 10 odd }
{ numbers and stores them in a }
{ special table called an array. }
foruse
QuickDrawl;
var
Data : array[1.10] of;
Index, Count : integer;
begin
{ Open Text window for viewing. }
HideAll;
ShowText;
{ Generate 10 odd numbers. }
Index :=1;
for Count = 1 to 19 try
begun
if odd( Count ) then
begun
Data[Index] <-- Count
Index : = Index + 1
end;

program Problem_Five(input, output);
{ This program generates 10 odd }
{ numbers and stores them in a }
{ special table called an array. }
uses
QuickDraw1;
var
Data : array[1..10] of integer;
Index, Count : integer;
begin
{ Open Text window for viewing. }
HideAll;
ShowText;
{ Generate 10 odd numbers }
Index :=1;
for Count :=1 to 19 do
begin
if odd(Count) then
begin
Data[Index] := Count;
Index := Index + 1
end;

Introduction to Macintosh Pascal
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end;
{ Display the 10 odd numbers. }
for Index : 1 to 10 do
writeln( Data[Index] );
end.
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end;
{ Display the 10 odd numbers. }
for Index := 1 to 10 do
writeln( Data[Index] );
end.

Exercises 6, 7, and 8 contain syntax and semantic errors that are only detected
when the program is checked or when the program is in execution. Select
Check Synta# from menu option Run to check for any syntax errors before
selecting 60 to execute. In each exercise the program on the left contains errors,
and the program on the right is correct. Our suggestion is to correct an error,
then repeat selection of the option Check Syntax to determine the next syntax

€Iror.

6. Check and run the following Pascal program, correcting all syntax and semantic

€Irors.

program Problem_Six(input, output);
{ This program detects division }

{ by zero. }

var

One, Two, Three, Four : real;

begin

ShowText;

One := 10;

Two :=20;

Three :=0;

Four := Two / Three + One;
writing ( 'Value of Four: ', Four )
end;

program Problem_Six(input, output);
{ This program detects division }

{ by zero. }

var

One, Two, Three, Four : real;

begin

ShowText;

One := 10;

Two :=20;

Three := 0;

Four := Two / ( Three + One );
writeln ( 'Value of Four: ', Four )
end.

7. Check and run the following Pascal program, correcting all syntax and semantic

€Irors.

program Problem_Seven(input, outpt);
{ This program generates 10 odd }
{ numbers and stores them in a }
{ special table called an array. }
uses
QuickDraw;
var
Data : array[1..10] of integer;
Index, Count : integer;
begin
{ Open Text window for viewing. }
Hide_All;
Show_Text;
{ Generate 10 odd numbers. }
Number :=1;

program Problem_Seven(input, output);
{ This program generates 10 odd }
{ numbers and stores them in a }
{ special table called an array. }
uses
QuickDrawl;
var
Data : array[1..10] of integer;
Index, Count : integer;
begin
{ Open Text window for viewing. }
HideAll;
ShowText;
{ Generate 10 odd numbers }
Index :=1;
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for Counter := 1 to 19 do

begin
if odd( Count ) then
begin
Data(Index) := Count
Index :=Index + 1
end;
end;

{ Display the 10 odd numbers. }
for Index :=1 to 20 do
writeln( Data( Index ) );
end.

Chapter 1 Introduction to Macintosh Pascal

for Count :=1 to 19 do

begin
if odd(Count) then
begin
Data[Index] := Count;
Index := Index + 1
end;
end;

{ Display the 10 odd numbers. }
for Index := 1 to 10 do
writeln( Data[Index] );
end.

8. Check and run the following Pascal program, correcting all syntax and semantic

€ITOrS.

program Problem_Eight(input, output);
{ This program displays 10 }
{ random numbers. }
var
A : array[1..100] of real;
Index : integer;
begin
{ Generate 10 random numbers. }
for Index := 1 to 10 do;
A[Index] :=random;
{ Display 10 random numbers. }
for Index := 10 downto 1 do
writeit( A[Index] :10:3,' ');
writeln();
end.

program Problem_Eight(input, output);
{ This program displays 10 }
{ random numbers. }
var
A : array[1..100] of real;
Index : integer;
begin
{ Generate 10 random numbers. }
for Index := 1 to 10 do
AlIndex] :=random;
{ Display 10 random numbers. }
for Index := 10 downto 1 do
write( A[Index] :10:3,' ");
writeln;
end.

9. Enter the code for the program Electric_Bill (listed on page 31 in Chapter 2).
Check the program and, if no syntax error is reported, run the program. Use
reasonable data, and enter it as it is requested. Save the program on your disk for
later use.

10. When executed, the following Macintosh Pascal program will generate a random
pattern in the form of ovals, as shown in Figure 1.21. Enter this program, check
for errors, and then choose an option to run.
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E[[=—— Drawing =——=0]

_

=)

Figure 1.21 Patterns generated by execution of the
program Random_Patterns.
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program Random_Patterns (Input. Output);

{ Purpose: This program draws ovals randomly in the Drawing }
{ window. }

uses
QuickDrawl;
const
Limit = 220;
var

Area : Rect;
Counter : integer;
Left, Top : integer;
begin
{ Open the Drawing window. }
ShowDrawing;
{ Draw patterns in Drawing window. }
for Counter := 1 to Limit do
begin
{ Establish coordinates for the upper left corner of the }
{ rectangle called Area. }
Left := - random mod 512 + 512;
Top := - random mod 342 + 342;
{ Establish the rectangle for drawing an oval. }




26 Chapter 1 Introduction to Macintosh Pascal

SetRect (Area, Left, Top, Left + 150, Top + 75);
{ Draw an oval filled with a black background. }
{ Intersection with any region of the Drawing window, }
{ being black, produces white.}
InvertOval (Area) ;
end;
end.

11. Try inserting stops throughout the program in Exercise 10 to observe its
execution?

12. Enter the following program, check for errors, and then choose the option to run.

program Problem_Twelve (input, output);
{ Purpose: This program provides random squares with different }

{ patterns throughout the Drawing window. }
uses
QuickDrawl;
var

Top, Left, Bottom, Right : integer;
Pat : Pattern;
Background : integer;

begin
{ Use function Random to choose the corners of the square }
{ and a background pattern. }

while true do

begin

{ Randomly select the rectangles for drawing an oval. }
Top := abs(random) mod 201;
Left := abs(random) mod 201;

Bottom := Top + 30;
Right := Left + 30;
{ Randomly select the background color. }

Background := abs(random) mod 5;
case background of
O.
Pat := white;
1 :
Pat := black:;
2 :
Pat := gray;
3
Pat := ltgray:;
4
Pat := dkgray:
end;

{ Display the oval in a rectangle with a chosen background }
{ pattern. }
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FillOval (Top, Left, Bottom, Right, Pat);
end;
end.

13. Enter the following program, check for errors, and then choose the option to run.

program Problem_Thirteen(input, output);
{ Purpose: This program draws a series of nested squares. }
uses
QuickDrawl;

begin

{Set PenSize for 15 wide and 15 high. }
PenSize (15, 15);

MoveTo (5, 20);
WriteDraw (' (25, 25)');
MoveTo (145, 20);
WriteDraw(' (175, 25)');

{ Draw the first square. }
DrawLine (25, 25, 160, 25);
LineTo (160, 160);

LineTo (25, 160);
LineTo (25, 25);

{ Draw the second square. }
DrawLine (55, 55, 130, 55);
LineTo (130, 130);

LineTo (55, 130);
LineTo (55, 55);

{ Draw third square. }
DrawLine (85, 85, 100, 85);
DrawLine (100, 100, 85, 100)

end.

14. Enter the following program, check for errors, and then run. Be sure that you
have saved a copy of the program before choosing the option to run. If you
encounter errors, cou2ct each error and save before again choosing the option to
run.

program Problem_Fourteen(input, output);
{ Purpose: This example shows how a region of arbitrary shape }

{ can be generated using several region procedures. }
uses
QuickDrawl, QuickDraw2;
type
Port = GrafPtr;
var

Window : Port;
Rectangle : array[l..2] of Rect;
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J : integer;
Actual_Rgn : array[l..3] of RgnHandle;

{ L EE XSRS SRS SRR RS RS R R SRR RRRRERREEREREEEEESEESEEESE] }

procedure Open_Window (var Viewport : Port);
begin

new (Viewport) ;

OpenPort (Viewport)
end; { Open_Window }

{ IE S S S E R R EEEE SRR R R RS RRERRR R R R R RRRRRRRRR Rt R R R R }

procedure Dispose_of_Window (wvar Viewport : Port);
begin
ClosePort (Viewport) ;
dispose (Viewport)
end; { Dispose_of_Window }

{ khkhkhkhkhkhkhkhkhkhkhkhkhkAA A hhkhkhkhhkhkhkhkhkhkhhkhkhkhkhkhkhkhkhkkhkhkkhhkhkhkkhkhkhkkkxk }

procedure Grow_Region (var Rgn : RgnHandle;
var Box : Rect;
Left, Top, Right, Bottom : integer);

begin

OpenRgn;

SetRect (Box, Left, Top, Right, Bottom);

FrameOval (Box) ;

CloseRgn(Rgn) ;
end; { Grow_Region }

{ % gk ok Kk sk ke ok de gk ok ke sk sk Kk gk sk kK sk sk K gk gk sk ke g sk gk ke %k gk sk e sk sk e sk ke ke ke ke sk ke ke ke ke ok ok k ke ke ke ok ke }
begin { Body of the main program. }
{ Hide all Macintosh Pascal windows. }

HideAll;
{ Establish two initial windows. }

Open_Window (Window) ;

for J := 1 to 3 do

Actual_Rgn[J] := NewRgn;

{ Generate the first region. }

Grow_Region(Actual_Rgn[l], Rectangle([l], 56, 73, 356, 273);
{ Generate the second region. }

Grow_Region(Actual_Rgn[2], Rectangle([2], 206, 103, 306, 243);
{ Generate third region. }

DiffRgn(Actual_Rgn[l], Actual_Rgn[2], Actual_Rgn[3]);
{ Show the third region. }

SetPort (Window) ;

Window” .clipRgn := Actual_Rgn([3];

FillRgn(Actual_Rgn[3], white);
{ Paint border on the edges of third region. }

PenSize (2, 2);

FrameRgn (Actual_Rgn[3]);
{ Draw in the third region. }
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MoveTo (100, 160);
TextFace([italic, underline]);
DrawString('Third Region');

{ Close windows and dispose of regions.

Dispose_of_Window (Window) ;
for J := 1 to 3 do
DisposeRgn (Actual_Rgn([J]);
end.
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Chapter 2

Introduction to THINK
Pascal

OBJECTIVES

After completing Chapter 2, you will know the following:
1. The general nature of the windows and menus used in THINK Pascal.
2. The concept of a project and how to create one.
3. The concept of a source program and how to create and edit a THINK Pascal
source program.
4. How to add a library to a project.
5. How to Check, Execute, Save, and Print THINK Pascal Programs.

2.1 INTRODUCTION TO THINK PASCAL AND THINK PASCAL WINDOWS

30

THINK Pascal is a development environment for generating Macintosh applications. It is
different from Macintosh Pascal in that (1) it supports a fast compiler, while Macintosh
Pascal is an interpreter; (2) it has a more advanced integrated text editor for Pascal syntax
than that found in the Program window of Macintosh Pascal; (3) it has an automated
Make utility for rebuilding various files linked with the development of an application;
(4) it has advanced debugging tools not found in Macintosh Pascal; (5) it includes a class
library and class browser for developing object-oriented programs; and (6) it includes a
project manager that binds various files into a single project. Programs written in
Macintosh Pascal can be compiled and executed in THINK Pascal. The reverse is not true,
since THINK Pascal supports extensions that are not supported in Macintosh Pascal.

The present THINK Pascal system (version 4.0) comes as a four-disk set and contains
instructions for unpacking many of the files. Following the instructions given in the
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manual, the complete development environment can be transferred onto a hard disk drive.
Although it may be possible to use THINK Pascal without a hard disk, you will find that
to do so is limiting and difficult. We strongly recommend that you not attempt to use the
software without a hard disk. By carefully following the instructions, you create a
development folder similar to the one shown in Figure 2.1, with the Pascal application
program in the folder called THINK Pascal 4.0 Folder.

ECI==——— Development ="

5 items 33,545K in disk 5,507K available
panN
THINK Pascal 4.0 Folder THINK Pascal 4.0 Utilities
THINK Pascal 4.0 Demos TCL 1.1 Pascal Demos

MacApp 2.0 for THINK Pascal 4.0

] [2A=)

Figure 2.1 The THINK Pascal Development folder.

Creating a THINK Pascal program is somewhat more complicated than creating a
Macintosh Pascal program. It begins with a step which may at first seem awkward and
unnecessary, the construction of a project. To illustrate the process, we will use an
example of a Pascal program entitled Electric Bill. The purpose of this program is to
allow you to take your electric bills for the past 12 months and, after entering the
consumption and cost figures for each month, get a monthly average for each of these
items. The listing for this program is as follows. (We will discuss the meaning of the
various lines in the program in the next chapter.)

program Electric_Bill (input, output);
{ Purpose: This program computes the total consumption and }
{ cost of electricity used over a 12-month period. }
var
Counter, Total_Consumption, Total_Cost : integer;
Consumption, Cost : integer;
Average_Consumption, Average_Cost : real;
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begin
ShowText;

{ Initialize Counter and totals. }
Counter := 1;
Total_Consumption := 0;
Total_Cost := 0;

{ Repeat entry of consumption and cost data until }
{ counter exceeds 12. }
repeat
{ Enter data from the keyboard. }
writeln('Enter consumption');
readln (Consumption) ;
writeln('Enter cost');

readln(Cost) ;

{ Compute the partial sums then modify the value of Counter. }
Total_Consumption := Total_Consumption + Consumption;
Total_Cost := Total_Cost + Cost;

Counter := Counter + 1;

until (Counter > 12);

{ Compute the average values of consumption and cost.}
Average_Consumption := Total_Consumption / 12;
Average_Cost := Total_Cost / 12;

{ Display the results. }
writeln('Average monthly consumption: ',
Average_Consumption : 7 : 2);
writeln('Average monthly cost:', Average_Cost: 6: 2)

end.

The first step in setting up a project actually occurs prior to launching the THINK
Pascal software. This step is to create an empty folder for the project and supply (make
accessible) any needed library files. For our example, we will create a folder entitled
Electric Bill Folder. We assume you have just turned on your Mac and the Finder window
is on the screen. To create this folder go to the Finder File menu and select New
Folder. Then change the name of the empty folder to Electric Bill Folder. Next move
this folder to the THINK Pascal Development folder, and open the THINK Pascal 4.0
Folder to locate the two library files you will need. Open the folder entitled Libraries, and
drag the files Runtime.Lib and Interface.Lib into the THINK Pascal 4.0
Folder. These two files are needed by almost all projects, and locating them in the same
folder as the project folder will make them accessible to the project.

The second step in creating a project is to launch the THINK Pascal application by
double clicking the THINK Pascal icon. If you loaded the THINK Pascal software
correctly, this application icon should be located in the THINK Pascal 4.0 Folder.
Opening the application results in a dialog box similar to the one shown in Figure 2.2.
Double click on the Electric Bill Folder (to keep your files neatly organized), and then
click New. A dialog box like the one shown in Figure 2.3 will appear. Do not be
concerned if the dialog boxes you see are not exactly the same as those shown in the
figures. The differences result from the different files in the folders when the dialog boxes
appear. Enter the name of the project, Electric_Bill.Project, as shown in
Figure 2.3. THINK Pascal has adopted the convention of using the symbol &t as a suffix
to indicate a project file. If you wish to follow this convention, you can produce the
symbol 7t by typing a character p while the option key is depressed.
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SN THINK Pascal 4.0 Folder

O Electric Bill Folder {» e Hard Disk
Y Interface.Lib

O Interfaces

(O Libraries

¥ Runtime.lib

O Source Programs

Create the project: [ create ]
| Cancel |

O Instant Project I

Figure 2.2 THINK Pascal opening dialog box.

&3 Electric Bill Folder

Eject

<l

il B

3

Create the project: IEBI

Electric_Bill.Project Cancel

] Instant Project 1

Figure 2.3 Naming and creating the project.
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To simplify and perhaps clarify matters, we have chosen to use the suffix project to
designate project files. Whichever approach you elect to take, designate the project name,
and then click Create. With this action you will create the project file.

The creation of a project results in the opening of a Project window, as illustrated in
Figure 2.4. Notice that initially the project contains only the two library files you placed
in the THINK Pascal 4.0 Folder. Specifically, they are the file Runtime.1ib and the
file Interface.lib. These files contain standard Pascal and Macintosh Toolbox
routines that almost all Pascal programs require in order to execute.

H Electric_Bill.Project
Options File (by build order) Size

g
I

(D

Runtime.lib 0
Interface.lib 0
Total Code Size 0

=<l

& D)

Figure 2.4 The Project window.

You are now ready for the third step in the creation of the project, the creation of the
source file. To accomplish this, select the command option New from the File menu.
This action results in the opening of an empty Edit window called Untitled-1. The Edit
window in THINK Pascal is the counterpart to the Program window in Macintosh Pascal.
Do not let this slight variation in terms confuse you. Type the program
Electric_Bill (exactly as shown on the previous page) in this window. Be aware
that punctuation can be critical. A misplaced semicolon can cause interesting results! The
Edit window has been designed to help you enter correct Pascal source code. If you enter
something incorrectly, you may see it displayed in outline font. If this occurs, you
will know there is an error. Test this by deliberately entering incorrect code and observing
the reaction of the Edit window.

When you have correctly typed the program, select Save As... from the File menu,
and name the source file Electric_Bill. To follow the THINK Pascal convention,
you would name it Electric_Bill.p. This convention uses the character p to denote
a Pascal source file and a T to denote the project file.!

As a fourth step in building the project, you must add the source file to the project.
To do this, select the Add “Electric_Bill” command option from the Project menu. If
there is not an active Edit window, this option will appear on the menu as Add Window

1'We have adopted the following convention for naming source-program files. If a program
will execute only as a Macintosh Pascal file, we will give it the suffix Mac. If it will execute
only as a THINK Pascal file, we will give it the suffix THINK. If it will execute in both
translators, we will use no suffix. Thus, a program named Circle.MAC would be a
Macintosh Pascal program, and a program named Circle.THINK would be a THINK Pascal
program. We hope this will be helpful in keeping the various kinds of programs separate. Be
careful to avoid confusing the Pascal program name, which appears in the first line of the
program, and the Macintosh file name. The former is an identifier and subject to the rules of
the identifier. The latter is a Macintosh file name and therefore much more flexible. This
difference accounts for the presence of the period in a file name such as Circle.Mac.
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and will be inactive (dimmed). If there is an Edit window but the source file has not yet
been saved, this command option will appear as Add “Untitled-17. Selection of Add
“Untitled-1” will result in an intermediate step with a dialog box instructing you to
save your source file. When this step has been successfully completed, the name of the
source file should be shown in the Project window, as illustrated in the top portion of
Figure 2.5.

O

|
i

Electric_Bill.Project

Options _ File (by build order) Size|&
Runtime.lib oA
Interface.lib Oﬁ

[DMN v R _Electric_Bill 0
Total Code Size 0

I2[<a]

|||
i

=[ == Electric_Bill.Project
Options File (by build order) Size

(oD

Runtime.lib 22820
Interface.lib 12812
[D[N]l v R Electric_Bill 602
""" Total Code Size 36234

EC0=—=Text

Enter consumption
100

Enter cost

20.27

.
Dl [k

@<

Figure 2.5 The Project window after addition
of the source file and then after compiling; the
Text window after execution of the program.

The fifth and final step in building the project is to select the 60 command option
under the Run menu. This causes the source file to be compiled. A dialog box indicating
that Electric_Bill is being compiled will appear for a few seconds. If all is well
with Steps 1 through 5, the program will now execute. If this is the case, the Text
window will appear, and information on your first month’s electric bill will be requested.
This is also shown in Figure 2.5. Notice that after the compiling step, the size of each
file in the project is given, as shown in the middle part of Figure 2.5. To complete the
execution of Electric_Bill, enter data for 12 months as prompted, and the program
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should provide you with summary statistics based on these entries. If for some reason you
wish to interrupt a program before execution is complete, the following applies. When a
program is in execution, a bug spray-can icon appears to the far right of the menu bar.
This icon appears only when a program is in execution and disappears once the program
has completed execution. Clicking on this icon or typing Command-Shift-Period
interrupts program execution. When a program has been interrupted, an Edit window is
opened with a finger pointing to the statement where the program stopped. Execution can
be continued by using any one of the command options—Go, Step Into, Step Over,
6o-Go, or Step-Step—from the Run menu.

The five steps in the building of a project can be summarized as follows:

1. Create the project folder, MyProgram Folder, and be sure the files
Runtime.Lib and Interface.Lib are located in the THINK
Pascal 4.0 Folder.

2. Create the project file, MyProgram. Project. Be sure this file is in
the project folder.

3. Enter the source code for the program in the Edit window, and save as it
as your source file, MyProgram. THINK.

4. Add this source file to the project. (Select the command option Add
“MyProgram.THINK” under the Pro ject menu.)

5. Compile and execute by selecting 60 under the Run menu.

Perhaps the best way to learn to use the Pascal software is to type a short program in
the Edit window and then go through each of these five steps. If you carefully complete
each step, you should be able to successfully execute the program at the end. If you have
not already done so, enter the program Electric_Bill. Just for good measure, you
might also try the shorter and simpler program, Circle. Go through Steps 1 and 2 as
outlined above, creating a project called Circle.Project. Then enter the following
source program in the Edit window. (You should recognize this program from Chapter 1.)

program Circle(input, output);
begin
ShowText ;
writeln('This is a circle.');
ShowDrawing;
PaintCircle(100,100,10);
end.

Save this source program as Circle.THINK, and add the file to the project. Select
Go to compile and execute the program. The result is shown in Figure 2.6. Notice that
the output of the program appears in two different windows and that the program contains
commands to ensure that the necessary windows are displayed. This is an important aspect
of creating a THINK Pascal program and one of the areas where THINK Pascal and
Macintosh Pascal differ somewhat. .

In order to keep this chapter brief, not all of the dialog windows we discuss are
shown. Some will appear in later chapters, and others should be explored by the reader.
We encourage you to apply each of the command options and to view and select options
from the various dialog windows in order to gain a better understanding of the command
options.
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Text
This is a circle. 4

Figure 2.6 Output from the program Circle.

2.2 THE THINK PASCAL MENUS

In this section we briefly describe the THINK Pascal menus and the commands found
under each one. Assuming that you are building on your experience from Chapter 1, our
introduction to the THINK Pascal menus will be brief. You are encouraged to further
review each menu by pulling it down and trying the various command options. Pay
particular attention to the choices provided by the dialog windows that result from
selection of some of the commands. Some of the menus have more than one set of
command options. To see these variations, press the Shift key and the Option key
(separately) while each menu is displayed. By pressing and releasing these keys several
times, you can easily see the different option sets of each menu. The Windows, Edit,
and Search menus have only one set of options. You are also encouraged to carefully
read the THINK Pascal User Manual.

2.2.1 The File Menus

Figure 2.7 shows the THINK Pascal File pull-down menu and its alternate (Option key
depressed) version. Most of the options under this menu are standard for Macintosh File
menus and need only be reviewed briefly. The New command results in a blank Edit
window. This is the command option you choose when a new source program is to be
entered. Open...2 allows you to open a previously saved THINK Pascal source file in the

2 The three dots following a menu command indicate that the selection of this option will
produce a dialog box. This is standard Macintosh symbolism.
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Edit window. THINK Pascal allows several Edit windows to exist within one project.
Open... also allows you to open additional Edit windows as needed. Close allows you to
close the active window, and Close Rl allows you to close all open files. Save allows
you to save the contents of the Edit window to your disk, while Save All allows you to
save all open files. Save a Copy fs... allows you to make backup copies without
erasing the file currently on disk. Revert allows you to replace the present contents of
the Edit window with the latest version of the current file that has been saved to disk.

New #EN New #N
Open... 80 Open... 80
Close $W Close All X
Save 4 Save All %8S
Save As... Save Rs...

Save a Copy fs... Save a Copy fs...
Revert Revert

Page Setup... Page Setup...

Print... ®P Print All Files xP
Delete... Delete...

Transfer... Transfer...

Quit 80 Quit %0

Figure 2.7 The THINK Pascal File menus. The menu on the right appears
when the option key is depressed.

Page Setup... results in the standard Macintosh Page Setup dialog box with its
various options (see Figure 1.19). Print... produces a dialog box (see Figure 1.18) and
results in the printing of the contents of the active window. Print RAll Files results in the
printing of all source files that have been added to the Project window. Delete... allows
you to remove a file from a folder without returning to the Finder. Transfer... allows
you to move to another application without first returning to the Finder. Under
MultiFinder, the THINK Pascal application will remain open if you transfer to another
application. Therefore you may return from the other application to THINK Pascal via
MultiFinder. Finally, Quit closes the THINK Pascal application.
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2.2.2 The Edit Menu

The various commands included under the Edit menu are shown in Figure 2.8. The top
part of this menu includes the standard Macintosh commands Undo, Cut, Copy, Clear,
Select All, and Show Clipboard. Undo allows you to undo the last edit operation.
The way this command is displayed can change according to the last operation that can be
undone. For example, in Figure 2.8 Undo is shown as Undo Typing, which tells you
that the last recoverable operation was the typing of text. Cut, Copy, and Paste allow
you to do further editing of your source file by cutting, copying, and pasting parts of the
file, while Clear removes the selected portion of the source file without placing it on the
clipboard. Select Rl selects the entire file for cutting or copying. Show Clipboard
allows you to view the contents of the clipboard.

Source Options... produces the dialog box shown in Figure 2.9 with options for
customizing the appearance of the source code. This option sets the characteristics for all
Edit windows within a single project. Through this dialog box you are able to control
four elements of the format of the display. First, you can select the font and font size in
which your source file will be displayed. Second, you may determine the way in which
keywords will be displayed (for example, lowercase bold print). Third, you may control
the indentation and tab size for your programs. Finally, you may control whether
parameter lists are displayed horizontally or vertically. Note that while Source
Options... is helpful in controlling the way your source program is displayed, it is not
critical to either your understanding of THINK Pascal or the operation of THINK Pascal.
Experiment with these options until you settle on a format that pleases you.

The next command option under the Edit menu is Auto-Reformat. Selection of
this option causes THINK Pascal to reformat your source file each time you press the
return key or type a semicolon. You may turn this off if you would prefer to have your
file reformatted less frequently. If you turn it off, you may still cause the file to be
reformatted at any time by pressing the enter key on the numeric keypad.

The final option under the Edit menu is Projector-Aware. This command option
applies when working on a large project using MPW projector. Refer to your THINK
Pascal User Manual for further discussion.

2.2.3 The Search Menu

The next menu on the THINK Pascal menu bar is Search, which is shown in Figure 2.8
along with the Edit menu. The command options in the Search menu allow you to
quickly find strings in your source files.? The Find... command results in a dialog box
where several options are allowed in searching for a string. You may look for separate
words or for strings embedded in other strings. You may specify whether or not case is
relevant in the search.

3 Strings will be discussed at some length in Chapter 11. For now, think of a string as a
collection of characters. For example, the word government is a ten-character string. A
string does not have to be a complete word, however. It can be part of a word (for example,
gove is a string embedded in the larger, string government) or several words (Good
government is hard to find is also a string) or even a number.
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Undo Typing %2 Find... RF
Find Again *®A

Cut ¥H Find in Next File ®T

Copy *®C Enter Selection RE

Paste £ [)

Clear Replace %A

Select Al Replace and Find Again 3D

Replace All

Show Clipboard

Show Selection
Source Options... Show Error

v Auto-Reformat

| Projector-Aware

F Find... %F
Find Again %A
Find in All Files RT
Enter Selection XE
Replace %A

Replace and Find Again 3D
Replace All

Show Selection
Show Error

Figure 2.8 The Edit and Search menus of THINK Pascal. The lower
Search menu appears when the Option key is depressed.

The Find Again command allows you to search for another occurrence of the same
string. The Find in Ne#t File command allows you to extend your search to more than
one Edit window. By pressing the Option key when you pull down the Search menu,
you can transform this option to Find in Rll Files. This option has the same effect as
repeatedly selecting Find in Next File. The last option in this group of commands is
Enter Selection. This option has the effect of selecting the highlighted string as the
new search string. Thus, you can start a new search sequence with this command.
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Source Display Settings

Frnt= Geneva 9
case program test;

CASE

case var

gase i, sum: integer;

Keywords |begin
sum := 0; {initialize to zero}
fori:=1to 10do

sum := sum + 1;
writeln('sum = ', sum);

begin

end
Indentation |end.

(3;b;¢)
3
b)

Parameters [Saue Settingsj [Cancel )

Figure 2.9 The Source 0ptions... dialog box.

The next group of commands, Replace, Replace and Find Again, and Replace
All, allow you to determine how to replace a string that is found. The Replace command
results in the currently selected string being replaced by a new string that you provide.
The Replace and Find Rgain command does the same thing as Replace and then
extends the search to the next occurrence of the string. Finally, the Replace AIl
command results in all occurrences of the string being replaced. Warning: This is a
dangerous command and should be used with considerable caution. It cannot be undone
with the Undo command.

The last commands in the Search menu are Show Selection and Show Error.
Show Selection lets you quickly return to the last insertion point in the Edit window
that is presently active. This is useful if you have been scrolling through a long file and
you would like to return to the last place where text has been inserted. The Show Error
option allows you to quickly locate the part of your file that has resulted in a compile
error. Show Error cannot be used to locate a run-time error.

2.2.4 The Project Menu

Figure 2.10 shows the THINK Pascal Project menu. The first group of command
options on this menu (New Project..., Open Project..., and Close Project) allow
you to create a new project, open an existing project, or close a project. The Add
“filename” command adds the source program in the current Edit window to the Project
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window. It is assumed that you have previously saved the source file. The Edit window
must be active when this command option is selected. The Add File... command allows
you to add a file to the Project window. This file may be a source file, an object file, or a
library file, If the project menu is pulled down with the option key depressed, this
command is changed to Add Files... . This command option results in a dialog box that
allows you to select multiple files from a folder and add them to the Project window in
one operation. The Remove command lets you remove files from the Project window.
In order for this command to work, you must first go to the Project window and highlight

the file to be removed.
Debug

New Project... LightsBug 8L
Open Project... 0 Instant
Close Project Observe
Add "Problem_Three" Show Finger
Add File... Pull Stops
Remove
v Auto-Show Finger

Build Library... v Stops In
Build Application... Break at A-Traps
Remove Objects

Use Second Screen
Set Project Type... Quietly Auto-Reset
Compile Options...
Diew Options... Monitor ®M
Get Info...

Figure 2.10 The Project and Debug menus.

The Build Library... command allows you to add the current project to your user
library for use with future projects. You will be asked to name the file, and the suffix
.LIB should be included to identify the resulting file as a library file. The Build
Application... option allows you to save the current project as an application, a desk
accessory, a driver, or a code resource. The Remove 0bjects command option removes
all the compiled code from a project. Further discussion of these commands is included in
Chapter 8.

The Set Project Type... command option allows you to designate a project as an
application, a desk accessory, a driver, or a code resource. For details on this option, see
the THINK Pascal User Manual. The Compile Options command allows you to
determine several factors in the compiling of your code. These include options for the
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compilation of source programs particular to specific microprocessors (68020/68030,
68881/68882 or 68000) as well as extended use of the uses clause. They also include
the ability to profile (analyze) the execution characteristics of a Pascal program. This
command option is discussed in a later chapter.

The View Options... command allows the appearance of the Project window to be
altered and allows the control of run-time options during the execution of a Pascal
program. These include checking for integer arithmetic overflow errors, various debugging
techniques, and range checking. The status of these options can be determined by the
absence or presence of boxes around the options D, N, V, and R beside each file in the
Project window. A box around the letter indicates that the option is active.

Finally, the Get Info command allows you to obtain information on the size of
each file in your project. Selection of this option results in a dialog box that lists each
file in the project. Select one of the files in the list to obtain information on the size of
that file.

2.2.5 The Run Menus

Three versions of the Run menu (see Figure 2.11) can be obtained by pulling down the
menu alone and in combination with the Option and Shift keys. The Option-key version
allows the user to elect automatic options for some of the commands in the original
menu. 60 becomes G0-60 and Step Into becomes Step-Step. The Shift-key version
of the menu, not shown in Figure 2.11, changes the Check Syntax command to
Compile.

The command option Check Synta# checks the source file in the Edit window for
proper use of Pascal grammar. It does not attempt to convert the source code to machine
code and has no effect on the Program window. The command option Compile checks
the source code in the Edit window for proper grammar and semantic meaning. If the
source code is correct in the use of grammar and in semantic meaning, this command
option also results in the generation of machine code and an update of the Project
window.

The next command option, Build, forces the system to compile all files that have
changed. The Check Link command causes all the files in the project to be linked. When
the execution of a program has been interrupted, the Reset command causes a paused
program to return to the beginning. Without Reset, a paused program will continue
execution from the point of the pause when it is resumed by the 60 or 60-60 command.

The Go command results in the execution of the program in the current Edit window.
If the file(s) need to be recompiled prior to execution, you will be so informed. The Go-
60 command (in the Option-key Run menu) is the automatic counterpart to the 60
command. If you have stops inserted in your source code, the 60-60 command will
result in an execution with a pause at each stop, followed by resumption of the execution.

The Step Over command results in the execution of the next line in your source
code. If your program includes a function or procedure, the entire routine will be executed
when the program line containing the call to the routine is reached. The Step Into
command is similar to the Step Over command, except that when a function or
procedure is encountered, the pointer goes to the first line of the routine. This allows you
to step through the function or procedure line by line. Functions and procedures are
discussed in Chapter 7.
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Check Syntax 38K || Check Syntax #K|| Compile RK
Build %8B Build #B|| Build ®B
Check Link Check Link Check Link
Reset Reset Reset
Go %6 Go-Go ®6|| Go 86
Step Over ®J Step Over $J|| Step Over %¥J
Step Into 81 Step Step ®I Step Into |
Step Out ®U Step Out #U|| Step Out ®U
Auto Save Auto Save Auto Save

vConfirm Saves vConfirm Saves vConfirm Saves
Don't Save Don't Save Don't Save
Run Options... Run Options... Run Options...

Figure 2.11 The THINK Pascal RUN menus. The center menu appears when the Option

key is depressed, and the right menu appears when the Shift key is depressed.

The Step-Step command is an automatic version of the Step Into command. It
executes each statement in turn with a pause to update the Observe and LightsBug
windows. The Step Out command causes the program to continue execution until it
exits the current routine. If you enter a routine with Step Into, Step Out allows you
to quickly exit that routine.

The Auto-Save option causes THINK Pascal to automatically save source files
before the program is executed. The Confirm Saves option causes THINK Pascal to
present a dialog box asking if you want to save your files when the program is executed.
The Don’t Save command causes THINK Pascal to do nothing about saving the file(s)
in the Edit window(s) when the program is executed. If you elect this option, you will
have to remember to save the file(s) with no aid from THINK Pascal.

The Run Options... command allows you to control several run-time environment
settings. These options include selection of the resource file the program will use,* the
number of characters that the Text window will save, echoing program output to the
printer or a file, selection of font and font size for the Text window, and the amount of

4 For the Macintosh, a resource includes pieces of code and data that support proper executions
at specific instants of time. This can include menus containing menu bars, icons and
character fonts, layout, and the content of dialog and alert boxes, as well as code within a
program. A resource file is a collection of resources stored as a unit on a disk. The THINK
Pascal Resource Utilities Manual has more information on how resource files can be created
and edited THINK Pascal supports several ResEdit resource editors as well tools for
compiling and decompiling resource description files.
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memory allocated for the project’s stack and heap. This dialog box is shown in Figure
2.15 in Section 2.3.2.

2.2.6 The Debug Menu

The Debug Menu is shown along with the Project menu in Figure 2.10. This menu
allows the user access to several devices that are useful in locating program bugs. The
LightsBug command results in the opening of the LightsBug window. The Instant
command results in the opening of the Instant Window, which can be used for instant
execution of individual statements when your program is paused.’ The Observe
command results in the opening of the Observe Window. This window allows you to
observe the values of variables and expressions during the execution of a program. The
Show Finger command makes the window that contains an execution error the active
window and shows the part of the window that contains the finger. The Pull Stops
command removes any stops previously inserted in your program. The Auto-Show
Finger command is an automatic version of the Show Finger command. The Stops
In command allows you to place stops in your program code. To do this, move the
cursor to the left part of the Edit window until it takes the shape of a stop sign. Click the
mouse button while the stop sign icon is visible, and a stop will be located before the
current program line. Stops allow you to step through a program in stages of your own
choice. This technique can be quickly refined with a little practice.

The Break at R-Traps command allows you to halt execution of your program
prior to a call to a Macintosh Toolbox routine. If you have more than one monitor, the
Use Second Screen option, when active, will use the second screen to display the
source and data windows. This option is available only when the Use Source
Debugger option is on. Quietly Auto-Reset will suppress the presentation of a reset
warning dialog box, which appears when you attempt to execute a halted program after
changing the source code. Finally, the Monitor command will move you into the low-
level debugger, (Macsbug or TMON).

The Option-key version of the Debug menu changes Pull Stops to Pull All
Stops. This command results in the simultaneous removal of stops from all of the files
in the project. The Shift-key version of the Debug menu presents New LightsBug as
its first option. This option results in a new LightsBug window being opened (up to
four can be open at once). This alternative menu also shows the command Use Monitor
as a replacement for the Monitor command. This command lets you determine which
debugger you will use when the software encounters an exception. If Use Monitor is on,
the debugger will be TMON or Macsbug. If it is off, the debugger will be LightsBug.

2.2.7 The Windows Menu

Figure 2.12 shows the Windows menu. The first command option (shown as
Prob.Project in Figure 2.12) appears as the name of the project. If there is no project
when the menu is displayed, it will appear as No Project, and the command will be

5 The Instant window Do It button is only active when a program has been halted. For
example, it will work when you insert a stop in a program and then activate the Step Over
command. Or it will work if you start execution of a program with GO and then halt it by
clicking the spray can.

6 Macintosh Toolbox refers to the group of ROM libraries supported by the Macintosh system.
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unavailable (dimmed). Selection of this command option activates and displays the

Project window.
Windows

Prob.Project 80

Arrange...
v Auto-Reopen
v Save Positions

Class Browser 3H

Text
Drawing

¢ Problem_Three 1
Available %2

Figure 2.12 The THINK Pascal Windows menu.

The Arrange... command allows you to arrange the Edit windows in several different
ways, including overlapping, tiled, side by side horizontally, or side by side vertically.
The Auto-Reopen command causes the same windows to open automatically when the
project is opened. The Save Positions command allows you to save the positions of
your windows when the project is closed. When the project is reopened, all windows
appear in the same position. The Class Browser command opens the Class Browser
Window, which is useful with object-oriented programming. The Text and Drawing
commands open the Text and Drawing windows, respectively. Finally, there is a list of
window commands (shown in Figure 2.12 as Problem_Three and Available) that
allow you to activate any of the currently open Edit windows. A diamond shown by one
of these filenames (see Problem_Three in the figure), indicates that the file has been
edited but the changes have not yet been saved.

2.3 CREATING A SOURCE PROGRAM: MORE DETAIL

As described in Section 2.1, a THINK Pascal program is always represented as a part of a
larger entity called a project. The project is a collection of linked files that make up the
program. To build a program, you need to know how to create the project document, how
to create the Pascal source program and edit it, and how to compile it and link it to other
files that will serve as subroutines for it. In this section, we explore a few details that
should help you understand this overall process and get you started as a THINK Pascal
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programmer. The details of some of these processes, however, are reserved for later
chapters.

2.3.1 Editing a THINK Pascal Program

A critical part of building a project is the creation of a proper source program. This is
done in the Edit window. Earlier in this chapter we discussed a program called
Electric_Bill. You were instructed to type this program into the Edit window and
then add it to a project. If you did this assignment successfully, you now have some
experience with the Edit window. You should now broaden that experience by
experimenting with other programs and by learning how the Edit window can help you
overcome problems. For example, many minor programming errors will be identified by
THINK Pascal as you work, by the appearance of the outline font in the Edit window
where the problem occurs. This is illustrated in Figure 2.13, where the program
Electric_Bill was changed to show a minor but common error.

[E0==—— Clectric_Bil =———=DF]

program Electric_Bill (input, output);
{ This program computes the total consumption and }
{ cost of electricity used over a 12 month period. }
var
Counter, Totalconsumption, Totalcost : integer;
Consumption, Cost: integer,;
Averageconsumption, Averagecost: real;

begin
{ Initialize Counter and totals. }
Counter = 1;

Totalconsumption := 0;

Totalcost := 0;
{ Repeat entry of consumption and cost data until }
{ counter exceeds 12 }

repeat

{ Enter data from the keyboard. }
writeln( Enter consumption’);
readin(Consumption);
writeIn('Enter cost');
readin(Cost);

Figure 2.13 An error in the source program may be revealed in the Edit
window in the form of an outline font.

The error in this case is the omission of a single quote in the writeln expression.
Notice that the resulting output indicates (by means of the hollow outline font) that
something is wrong, but the computer does not identify the specific problem. You will
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have to learn through experience how to interpret a result such as this. Fortunately, it is
not difficult to develop this skill.

Another way of spotting errors as you type the program into the Edit window is
through the use of the Check Syntax command under the RUn menu. At any time, you
can check your source code by selecting this option. For example, modify the
Electric_Bill source program by removing the word Counter from the variable
declaration list. Then select the Check Syntax command and watch the result. The error
message shown in Figure 2.14 will appear. The bug icon in the message informs you
that there is an error, or bug, in your program. The description of the bug in the error
message should give you a clue about the problem. In this example, the message is very
helpful in identifying the problem, since it tells us that the identifier Counter has not
been declared. Before going on to correct the problem, you must click on the error
message box to remove it from the screen.

"Counter" is not declared.

{ This program computes the total consumption and }
{ cost of electricity used over a 12 month period. }

var
Totalconsumption, Totalcost : integer;
Consumption, Cost: integer;
Averageconsumption, Averagecost: real;
begin

{ Initialize Counter and totals. }
B{H Counter := 1;
Totalconsumption := 0;
Totalcost := 0;
{ Repeat entry of consumption and cost data until }
{ counter exceeds 12 }
repeat

{ Enter data from the keyboard. }
writeln(‘Enter consumption'); 4

D] =

Figure 2.14 Using the Check Syntas command to locate a programming error.

2.3.2 Using the Printer

You can use your printer to make a paper copy (hard copy) of the material displayed in
any window. For example, if you would like a hard-copy listing of a Pascal source
program, activate the Edit window that contains the source code, pull down the THINK
Pascal File menu, and select Print... A print dialog box (familiar to the experienced
Macintosh user) will appear and offer you the usual print options, such as the quality of
print, the page range, the number of copies, and paper feed. The options offered will
depend upon the printer connected to your computer or the printer you have selected if you
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are working on a network with several printers available. An example of a print dialog
box is shown in Figure 1.18.

After you enter your option choices, the printing will proceed. You may print the
contents of the other windows by clicking the desired window (making it active) and then
electing the Print command on the File menu. By selecting the Run Options...
command option of the Run menu, you may elect to have the output of your program
directed to the printer as well as to the screen. Figure 2.15 shows the dialog box when
this option is selected.

Run-time Environment Settings

[J Use resource file:
for resources used by the project.

Resources

Text Window saves |50080 (characters
Text X Echo to the printer
Window [JEcho to the file:

Hello world. x = 811.79

Monaco 9
stack size:([J3ll|ilobytes | 0K
Memory
Zone size |128 |kilobytes | Cancel

Figure 2.15 Directing output to the printer. The dialog box from the Run
Options... command under the RUN menu.

2.3.3 Creating a Generic Project: A Helpful Shortcut

As you get into Chapter 3 and begin entering many short Pascal programs, testing and
exploring various points discussed in the text, you will find the process of creating a
project for each source program to be both tedious and costly in disk space. As a result,
you might want to create a generic project that you can use with any source program to
test its execution. Create a project in the usual way and name it General project. When
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the source file has been typed into the Edit window, use the Add “filename” command

under the Project menu to add the source file to the project. Compile and execute the
program, and observe the effect. When you are done, select the source file name in the
Project window (drag the cursor over the name), and click Remouve under the Project
menu. The generic project is then ready to receive the next source file. You might also
want to keep a folder to collect the source programs as you type them. It is efficient to
collect source programs, since they do not take up very much room on disk. Having these
files available will save you time later, since some of the early programs may need to be
modified and improved as you learn additional techniques. Remember, however, that you
will have to add the source file to a project and compile it before you can execute it again.

2.3.4 Creating an Instant Project

Another shortcut you might find helpful is the instant project. When you select the New
Project... option from the Project menu, you will see an Instant Project box near the
bottom. Click this box, and type a name for your project in the appropriate place on the
dialog box. Do not try to include a suffix in the name (such as & in the name Project.r).
THINK Pascal will automatically create and name the folder, the project file, and an
outline source file (in the Edit window), naming each with the name you provided and
attaching an appropriate suffix. The outline source file is similar to the one you see in
Macintosh Pascal when the Program window is first opened. It can be used or discarded
using the Delete... command option from the File menu.

SUMMARY

This chapter reviews the menus and command options of THINK Pascal, a development
environment for generating Macintosh applications. It is different from Macintosh Pascal
because it supports a project manager that binds files into an entity called a project.
THINK Pascal supports a fast compiler for translating Pascal source code, an advanced
text editor for Pascal syntax, an automated make capability for rebuilding source files,
advanced debugging tools such as a debugger and profiler, and a class library for
development of object-oriented programs.

The File menu contains the command options New, Open..., Close, Close All,
Save, Save All, Save As..., Save a Copy As..., Revert, Page Setup..., Print...,
Print All Files, Delete..., Transfer..., and Quit. Where Macintosh Pascal allows only
a single window for program development, THINK Pascal allows several Edit windows to
be opened, using either the command option New or the command option Open....

The Edit menu supports standard Macintosh command options such as Undo, Cut,
Copy, Paste, Clear, Select Rll, Show Clipboard, as well as added command
options such as Source Options..., Auto-Reformat, and Projector-Aware. The
Search menu supports the command options Find..., Find Again, Find in Next File,
Find in Rll Files, Enter Selection, Replace, Replace and Find Again, Replace
All, Show Selection, and Show Error. These command options allow more string
search and replacement options than found in Macintosh Pascal.

The Project menu has numerous command options for working with the current
project, including New Project..., Open Project..., Close Project, Add
“filename"”, Add File..., Add Files..., Remove, Build Library..., Build
Application..., Remove 0Objects, Set Project Type..., Compile Options...,
Uiew Options..., and Get Info.... The Run menu has command options that support
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syntax checking, the translation and building of files, as well as control over execution of
a THINK Pascal program. These commands include Check Syntax, Compile, Build,
Check Link, Reset, Go, 6Go-Go, Step Over, Step Into, Step-Step, and Step
Out. Additional command options include Auto Save, Confirm Saves, Don't Save,
and Run Options....

The Debug menu allows for some of the same windows to be opened when
analyzing the execution of source code as in Macintosh Pascal, as well as added command
options not in Macintosh Pascal. These include LightsBug, New LightsBug,
Instant, Observe, Show Finger, Pull Stops, Pull All Stops, Auto-Show
Finger, Stops In, Break at A-Traps, Use Second Screen, Quietly Auto-
Reset, Monitor, and Use Monitor. The Windows menu allows the programmer to
work with and position many of the various THINK Pascal windows. The command
options under this menu include the Project window name, Arrange..., Auto-Reopen,
Save Positions, Class Browser, Text, Drawing, as well as a list of all file names
for current Edit windows.

Pressing the Shift or Option keys while the menu is down produces alternative
commands for the File, Search, Project, Run, and Debug menus. In addition to the
command options under these THINK Pascal menus, there are numerous dialog windows
offering options that can affect the viewing of Edit, Text, and Project windows. With the
dialog window produced by selecting the Run Options... command, the programmer can
direct text from the Text window to a printer as well as to a file. In addition, the type of
font, font size, and the total number of characters saved in a Text window can be changed.

REVIEW QUESTIONS

1. What is a project?
2. What are the general steps involved in the creation of a project?
3. What characters can be used in titling a THINK Pascal source file?
4. What is the maximum number of characters for a Macintosh file name?
5. How do you rename a file that has already been created when using THINK
Pascal?
6. What differences have you seen so far in Macintosh Pascal and THINK Pascal?
7. The first line of any THINK Pascal program begins with what command?
8. What are the rules for naming an identifier?
9. What are the eight menu options for THINK Pascal?
10. What command options exist when selecting the Run menu?
11. What command options exist when selecting the Edit menu?
12. What command options exist when selecting the Window menu?
13. What is the purpose of the Project window?.
14. What is the purpose of the Check Syntas option?
15. What is meant by the term debugger?
16. How can stops be inserted and removed in a THINK Pascal source program?
17. What is the purpose of the Observe window? How is this window used to
locate a program bug?
18. What are the first steps in writing a THINK Pascal program?
19. What is the difference between the options Print and Print RIl ?
20. How can you edit your program after it has been compiled?
21. What is the purpose of the Clipboard?
22. What is the purpose of the Text window? The Drawing window? The Instant
window?
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23. What is the purpose of the Reset option??

24. How can a program displayed in the Program window be printed?

25. How can output from a program be directed to a printer?

26. How do you display alternate forms of the THINK Pascal menus?
Which menus have alternate forms?

27. How does one create an Instant Project?

28. What is the purpose of a generic project? What is the advantage of this
approach when writing many small programs?

PROGRAMMING EXERCISES

1. Create a generic project for the purpose of testing the following program
as well as the remaining programming exercises in this chapter. After
the project has been created, enter the following test program in a new
Edit window. This program simply displays a message in the Text
window:

program Exercise_One (input, output);
{ Purpose: This program will be used to test the Instant window. }
begin
writeln(' This is a sample program for testing the Instant
window. ') ;
end.

Using the command option Check Syntax, check the program
Exercise_One for syntax errors. Correct any errors that exist. Be
sure to use the Save As and Save options for saving the source code
to a file. To test the Instant window, place a stop at the left of the
keyword begin and then execute this program using the G 0
command. The program will be halted with a finger pointing to the left
of the word begin. Open the Text and Drawing windows from the
Windows menu and then choose the Instant command from the Debug
menu. Enter the following statements into the Instant window. After
entering a source line, press the "Do It" button, and observe the
response. This exercise will require the following command options:
New Project, New, Save fis, Save, Add “"filename", Check
Syntax (or Compile), Stops In, 6o, Text, and Drawing.

2. Using the generic project from Exercise 1, remove the current program
using the Remove command after highlighting the Pascal program in
the Project window. Then, after closing the current Edit window, apply
the command New, and enter the following Pascal program.

program Exercise_Two (input, output);
{ Purpose: This program prompts for and displays your name.}
var
Name : string[30];
begin { Body of main program.}
ShowText ;
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{ Prompt for a name entered from the keyboard. }
write('Enter your full name and then press the return key: ' );
readln (Name) ;

{ Display the name entered from the keyboard. }
writeln('Your name is ', Name);

end.

Apply the Check Syntax command, and correct any improper
syntax. Now apply the following options from the Source Options...
dialog window: select font as Geneva, 10 point; select keywords
lowercase and underlined; select indentation and tabs at 8 spaces. Now
use the command option Add “filename", and add the program to the
Project window. Apply the command Build to complete building the
project, and execute the program using the command Go.

3. For the program in Exercise 2, select the following options from the
Run options... dialog box: for the Text window, select a font of type
Geneva and a font size 20; for the Text window select saving only 10
characters. If a printer is available, select the option to echo to the
printer. Then again build the project with the Build command, and
observe execution of the program, using the 60 command. Observe the
execution of the program when you attempt to enter a name longer than
30 characters. Try using the commands Go, Go-Go, Step Into,
Step-Step, and Step Over to continue execution.

4. For the program in either Exercise 2 or 3, remove the present Pascal
program from the Project window, and add the following source
program in a new Edit window:

program Exercise_Four (input, output);
{ Purpose: This program displays 10 numbers to the Text window. }
var
Counter : integer;
begin
{ Hide all windows but the Text Window. }
Hideall;
ShowText ;
{ Display 10 numbers to the Text window. }
for Counter := 1 to 10 do
writeln( Counter );
end.

Apply the Compile command option, and correct any improper
syntax. Now apply the following options from the Uiew Options...
dialog window: select the font as Courier, 10 point; set all of the other
options to your taste. Now look at the Project window and observe its
new characteristics. Using the command option Add "filename", add
the Pascal program to the Project window. Apply the command Build
to complete building the project, and execute the program with the
command Go. Notice that the Pascal command HideAll will hide all of
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the windows before it opens the Text window. How can the Edit
window be opened to again view the source file after the program ends
execution?

5. Modify the program in Exercise 4 by removing the comments in the
body and modifying the comment representing the purpose. In addition,
cut the statements writeln, HideAll, and ShowText. Your Edit
window should now have the following listing:

program Exercise_Four (input, output);
{ Purpose: This program provides a trace during execution by }

{ displaying 10 numbers in the Observe window. }
var
Counter : integer;
begin
for Counter := 1 to 10 do
end.

Using the command option Stops In, place a stop before the line
containing the word begin. Now open the Observe window, and
enter the name Counter at the top of right column. Then apply the
command option 60 and begin execution. Since the program will be
interrupted, choose the command Step-Step to observe the values of
Counter as the program executes. Be sure that the box D is set for
the Pascal program file listed in the Project window.

6. Modify the program in Exercise 5 to appear as shown below:

program Exercise_Four (input, output);
{ Purpose: This program provides a trace during execution by }

{ displaying 11 numbers in the Observe window. }
var

Counter : integer;
begin

Counter := 1;

while Counter <= 10 do

Counter := succ( Counter );

end.

Add the expression " Counter <= 10 " below the word
Counter in the Observe window. Remove the stop before the word
begin and place a stop before the word while. Again execute the
program with the command G0. Continue to execute the program with
the command 60, and observe all the values for the two expressions in
the Observe window. Be sure that the box D is set for the Pascal
program file listed in the Project window.
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7. After removing the file for the present Pascal program from the Project
window, create a new Edit window, and add the following Pascal
program:
program Random_Patterns (input, output) ;
{ Purpose: This program draws ovals randomly in the Drawing }
{ window. }
const
Limit = 220;
var
Area : Rect;
Counter : integer;
Left, Top : integer;
begin
{ Open the Drawing window. }
ShowDrawing;
{ Draw patterns in Drawing window. }
for Counter := 1 to Limit do
begin
{ Establish coordinates for the upper left corner of the }
{ rectangle called Area. }
Left := - random mod 512 + 512;
Top := - random mod 342 + 342;
{ Establish the rectangle for drawing an oval. }
SetRect (Area, Left, Top, Left + 150, Top + 75);
{ Draw an oval filled with a black background. }
{ Intersection with any region of the Drawing window, }
{ being black, produces white.}
InvertOval (Area) ;
end;
end .
After you have entered the program and removed all errors, add the
program to the Project window and execute. You may need to open the
Drawing window and adjust its size before execution.
8. The following prog...m will result in an error during execution. Enter
the program in your generic project, and observe the bug's box that is
generated when Counter reaches a value of 10:
program Exercise_Eight( input, output);
{ Purpose: This program displays 11 numbers to the Text window. }

var
Counter : 1..10;

begin

{ Hide all windows but the Text Window. }
Hideall;
ShowText ;

{ Display 10 numbers to the Text window. }

Counter := 1;
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while Counter <= 10 do
begin
writeln( Counter );
Counter := succ( Counter );
end;
writeln( Counter );
end.

Be sure that the boxes D and R are set for the Pascal program file
in the Project window. What is the last value of Counter displayed in
the Text window? After you have observed the appearance of the bug's
box reporting the error, remove the option R for the Pascal program file
in the Project window, and again execute the program. What is the last
value of Counter displayed in the Text window?

9. The following program will result in an error during execution, provided
that option V is set for the source file in the Project window. Enter the
program in your generic project, and observe the bug's box that is
generated when 1 is added to Number.

program Exercise_Nine (input, output);
{ Purpose: This program displays 11 numbers to the Text window. }
var
Number, Counter: integer;
begin
{ Hide all windows but the Text Window. }
Hideall;
ShowText ;
{ Display 10 numbers to the Text window. }
Number := 32767;
for Counter := 1 to 10 do
begin
writeln (Number) ;
Number := Number + 1;
end;
writeln( Number );
end.

Remove option V from the Project window for this file, and again
execute the program. What values appear for Number in the Text
window? What is wrong with these values?

10. Implement the following program, using your generic THINK Pascal
project:

program Exercise_Ten;

{ Purpose: This program draws a series of nested squares in the }
{ Drawing window. }
begin

{ Display the Drawing window to the screen. }
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ShowDrawing;

{Set PenSize for 15 wide and 15 high. }
PenSize (15, 15);

MoveTo (5, 20);
WriteDraw (' (25, 25)');
MoveTo (145, 20);
WriteDraw(' (175, 25)');

{ Draw the first square. }
DrawLine (25, 25, 160, 25);
LineTo (160, 160);

LineTo (25, 160);
LineTo (25, 25);

{ Draw the second square. }
DrawLine (55, 55, 130, 55);
LineTo (130, 130);

LineTo (55, 130);
LineTo (55, 55);

{ Draw third square. }
DrawLine (85, 85, 100, 85);
DrawLine (100, 100, 85, 100)

end.
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11. Implement the following program using your generic THINK Pascal
project. Selecting the command option Source Options..., set all
options and establish indentation and tabs at 5 spaces. Your Edit
window should appear as in the listing that follows:

program Exercise_Eleven;
{ Purpose: This program draws random circles having random }
{ patterns within the Drawing window. }
var
Top, Left, Bottom, Right: integer;
Pat: Pattern;
Background_Pattern: integer;
begin
{ Show the Drawing window before painting any ovals. }
ShowDrawing;
{ Use function random to choose the corners of a square and a }
{ background pattern. }
while true do
begin
{ Randomly select a rectangle for drawing an oval. }
Top := abs(random) mod 201;
Left := abs(random) mod 201;
Bottom := Top + 30;
Right := Left + 30;
{ Randomly select the background pattern. }
Background_Pattern := abs(random) mod 5;
case Background_Pattern of
0:
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Pat := white;
1:
Pat := black;
2:
Pat := gray:;
3:
Pat := ltgray:
4:
Pat := dkgray;
end;

{ Display the oval in a rectangle with a background pattern from }
{ the above step. }

end.

FillOval (Top, Left, Bottom, Right, Pat);
end;

This program will continue to execute indefinitely. You can terminate
execution by clicking the spray-can icon to the far right of the menu
bar.

12. If you have a color monitor, add the following Pascal code to the body
of the program of Exercise 11. This code should follow the case
statement that assigns a value to variable Pat. When executed, the
modified program displays ovals, using random background colors as
well as random patterns:

{ Randomly select the background color. }

Background_Color := abs(random) mod 8;
case Background_Color of
o Color := blackColor;
t Color := whiteColor;
2 Color := redColor;
> Color := greenColor;
¢ Color := blueColor;
> Color := cyanColor;
o Color := magentaColor;
7 Color := yellowColor;
end;

{ Display the oval in a rectangle with a background color chosen }
{ from the above step. }
BackColor (Color) ;

Be sure to add the following declarations under vaxr:
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Background_Color : integer ;
Color : longint;

Replace the command BackColor (Color) with ForeColor
(Color), and observe the change in appearance for ovals drawn on the
screen.

13. Using your own programs, try the command options Save a Copy fis,
Transfer, Delete, Remove 0Objects, Find, Find Again, Close
Project, Open Project, Add File..., Quitely Auto-Reset, and
Show Finger.
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Chapter 3

Constants, Variables, and
Simple Input and Output

OBJECTIVES

After completing Chapter 3, you will know the following:

1. An introduction to problem solving and the algorithm.

2. The general format used in both Macintosh Pascal programs and THINK Pascal
programs, including the use of the program heading, the identifier, declarations,
and the reserved words begin and end.

3. The concept of a data object, including constants and variables.

4. The use of the Macintosh Pascal and THINK Pascal input commands read and
readln and the output commands write and writeln.

5. Simple Macintosh data types, including the real data types (real, double,
extended, and computational) and the ordinal data types (integer, longint,
char, Boolean, enumerated, and subrange).

3.1 PROBLEM SOLVING

60

Programming involves the following steps: (1) identifying a problem that requires a
solution, (2) finding the solution to the problem, (3) specifying the ordered set of steps
that represent the solution, and (4) implementing these steps in a computer language. In
reaching a solution to a problem, we must be concerned with analyzing the problem,
finding the steps for a solution, and then formally defining the set of steps. A computer
language such as THINK Pascal is a tool for implementing our solution on a computer.
Although it may appear to the beginner that the computer provides an answer to a
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problem when a program is executed, the computer itself does not directly solve
problems; it is programmed to provide an answer or answers for either one problem or a
class of problems.

The first step in obtaining a solution to a problem is problem analysis: the problem
is defined, and all the information needed for a solution is identified. Problem analysis
consists of the following steps:

1. Define the problem precisely. This implies being able to write a short description
defining the problem to be solved. If this cannot be done, more time is needed to
think about the problem.

2. Determine whether the problem has already been solved. Is it possible that
programs already exist for performing the task being studied? Is it possible to
modify an existing program to provide a solution?

3. List all the desired information required as input. What is required as input to
solve this problem? If you cannot recognize the input requirements, more
thinking is required about the problem you are trying to solve.

4. List all the desired information required for output, including a representation of
an answer to the problem being solved.

5. Begin with an initial set of steps as an approximation of a solution. Do these
initial steps identify any subproblems that need to be solved (need to be broken
down into smaller steps)?

6. Refine the steps so that they are precise and explicit. This is important because a
computer program will be based on these steps. If they are not precise and
explicit, it may not be possible to translate the solution into explicit computer
commands. Often it is necessary to repeat Steps 1 through 6, refining the
solution in stages.

7. Trace each step of the solution with known information. This allows us to
understand how intermediate values are created and changed and to detect steps
that are imprecise or not explicitly defined.

The product of this process is an algorithm. An algorithm is a procedure having a
finite number of unambiguous steps specifying a sequence of operations that provide a
solution to a problem. Consider some of the key words in this definition. First, an
algorithm is a procedure. By following the steps of an algorithm, we can obtain a
solution to a problem. Second, the steps are finite; they do not go on forever. Third, the
total number of steps is not fixed for all problems. Finally, each step is unambiguous;
that is, it is precise and ¢ mlicit. A proper algorithm must satisfy the following
characteristics:

1. Finiteness. There must exist a finite sequence of steps leading to an answer. If this
is not true, further analysis is required.

2. Definiteness. There must be preciseness of meaning. Each step must be explicit
and precise in defining its actions. If any step fails to have this property, it
should be treated as a subproblem in itself and subjected to further analysis.

3. Input. A list of information to be entered through what we call input data objects
or input variables.

4. Output. A list of information to be reported through what we will call output data
objects or output variables.

5. Effectiveness. All steps must be able to be completed in a finite length of time by
any individual tracing the steps of the algorithm.
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If an algorithm fails to satisfy one or more of these five properties, it is necessary to
perform additional analysis. It is important to understand that a computer program is
simply one form for expressing an algorithm. A computer program that fails to execute
properly also fails to satisfy one or more of the characteristics of an algorithm.

The steps of an algorithm can be expressed in several forms. It is possible to express
them in a natural language such as English. The problem with this approach is that the
English language can be ambiguous and thus lead to confusion. A second approach to
expressing an algorithm is symbolic representation. Each step of the algorithm can be
represented by means of a flowchart symbol. Unfortunately, there are numerous
commands in THINK Pascal for which no standard flowchart symbols exist. In addition,
developing large algorithms with flowcharts is messy. A third approach is to use an
artificial language similar to the commands of Pascal for describing the steps. This is the
approach that we will take, and later you will be shown how Pascal itself can serve as a
vehicle for defining algorithms.

3.1.1 Developing an Algorithm: An Example

An example will help clarify the foregoing discussion. The following discussion is keyed
to the steps just presented.

1. Suppose that we want to use our computer to compute average monthly
consumption and cost for our electric bills over a 12-month period. Assume that
we will first enter 12 values each for consumption and cost and then display the
following messages

Average Monthly Consumption :
Average Monthly Cost :

with the computed values printed to the right of the colons. This description of
what we want to do constitutes our definition of the problem.

2. Next, determine if the problem has already been solved. While it may be possible
to purchase software for the Macintosh that will perform these calculations, we
will assume that a suitable program does not exist. Thus, we must provide our
own solution to the problem.

3. List the necessary input for a solution. Obviously, we need our electric bills for
the past 12 months, and from these we must take the figures on consumption
(the number of kilowatt-hours used) and cost (the dollar amount charged for our
electric usage for each month).

4. Then list the information required for output. In the case of our electric bill, we
need the average consumption and the average cost. Our output will also contain
labels that will identify these figures.

5. Next we must provide an initial set of steps for the solution of our problem.
These might appear as follows:

(a) Prompt the user with a message to enter the month's consumption and cost
figures.

(b) Add consumption to a partial sum for storing total consumption over 12
months. Follow the same procedure for cost.

(c) Repeat Steps (a) and (b) 11 times.
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(d) When we have completed these 12 iterations, compute the averages by
dividing the sums for consumption and cost by 12.
(e) Report these average values to the user.

These steps represent an algorithm, but do they satisfy all the requirements of an
algorithm? First, the steps are finite even though Steps (a) and (b) are to be performed 12
times. Second, some of these steps must be more precise. For example, Step (b) should
be more specific as to what names can be used for representing the partial and total sums.
We must also be more specific on how we intend to control the iteration of Steps (a) and
(b). That is, we should introduce a counter to control these iterations. Third and fourth,
the steps for input and output will have to be more precise in expressing these two
actions. Fifth, if you trace the steps by hand (using pencil and paper), this algorithm can
be executed in a finite number of steps.

6. The sixth step in the process is to refine the Steps (a) through (e) of Step S so
that they are precise and explicit. Because of the need for greater precision, we
will rewrite those steps in a more formal style that resembles the style of a
Pascal program. For now, you should at least be aware that the use of the braces
{ } designates a comment, which plays no active part in the program itself.

(a) { Prompt user to enter both consumption and cost }
{ values from the keyboard. }
write 'Enter Consumption'
read Consumption
write 'Enter Cost'
read Cost

(b) { Compute the partial summations. }
Total_Consumption <-- Total_Consumption +

Consumption

Total_Cost <-- Total_Cost + Cost

(c){ If we have not yet reached a count of 12, go }
{ back to Step (a) and repeat Steps (a) and (b). }
If count of 12 or less, go to Step (a)

(d) { Compute the average values of consumption and }
{ cost. }
Average_Consumption <-- Total_Consumption / 12
Average_Cost <-- Total_Cost / 12

(e) { Display the results. }
write 'Average Monthly Consumption:',

Average_Consumption

write 'Average Monthly Cost: ',Average_Cost
{ End of solution. }

These steps are finite, but there is still some ambiguity; when we retrace the steps,
we find that no initial values have been set for Total_Consumption and
Total_Cost. We might assume these values will initially be set to zero, but we have
done nothing in our algorithm to ensure this. This should be done prior to Step (a). We
also need to set up a counter that will start at 1 and increase in increments of 1 with each
iteration of the data-entry cycle. This counter will be tested to determine if it is less than
12, in which case the cycle should be continued, or if it is time to compute the averages.
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The following instructions incorporate solutions to these problems and refine the
algorithm for computing the average power consumption for one full year.

Algorithm Electric_Bill;

{ Initialize counter and totals. }
Counter <-- 1
Total_Consumption <-- 0
Total_Cost <-- 0

{ Repeatedly enter consumption and cost until counter
exceeds 12. }
repeat

write 'Enter Consumption'
read Consumption
write 'Enter Cost'
read Cost
{ Compute the partial summations. }
Total_Consumption <-- Total_Consumption +
Consumption
Total_Cost <-- Total_Cost + Cost
Counter <-- Counter + 1
until (Counter is greater than 12)

{ Compute the average values of consumption and cost.}
Average_Consumption <-- Total_Consumption / 12
Average_Cost <-- Total_Cost / 12

{ Display the results. }
write 'Average Monthly Consumption: ',

Average_Consumption
write 'Average Monthly Cost: ', Average_Cost

{ End of algorithm. }

What about the algorithms for the read and write commands? For the present we
will accept these as given, just as we accept the basic operations of addition and division.
For your reference, the finished program is shown in Section 2.1 of Chapter 2.

3.2 THE FORMAT OF A PASCAL PROGRAM: ADDITIONAL DETAIL

A Macintosh Pascal or THINK Pascal program is composed of several parts, including a
program heading, a uses clause, a declaration part, and a statement part. For now, we
will refer to the statement part as the executable body of the program. Figure 3.1 shows
the typical format for a Macintosh Pascal and THINK Pascal program.

In this figure the program heading begins with the reserved word program
followed by an identifier representing the program title. We refer to program as a
reserved word because it can only be used in the context for which it is defined (in this
case defining the beginning of a Pascal program). Any attempt to use the word
program in a context other than defining the beginning of a Pascal program results in
this word being displayed in outline type, indicating that a syntax error has occurred.
Appendix A includes a complete list of reserved words for both the Macintosh Pascal
language and the THINK Pascal language.
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[J=——= Untitled E

program Program_Name(input, output);
{ Uses clause }
uses
Library_Name;
{ Declaration Parts }
const

type
var

begin

{ Executable body of the program }

i<l

Figure 3.1 Format for a Macintosh Pascal or THINK Pascal
program.

Since the program title is an identifier, it is subject to the rules discussed in Section
1.3 of Chapter 1. Specifically, an identifier must begin with a letter of the alphabet, and
this letter can be followed by letters of the alphabet, the digits O through 9, and/or an
underscore ( _ ) character. Other characters, including blanks, are illegal. In addition, an
identifier can be up to 255 characters long. Upper- and lowercase letters are not interpreted
as being different in identifiers; their use is completely at your discretion. Our convention
in naming identifiers is to begin with a capital letter followed by letters or digits, with
the underscore being used to separate full words. For example the name
Taxableincome is represented as Taxable_income or Taxable_Income. You
may prefer not using the underscore and beginning each distinct word with a capital letter.
For example, you could use the name TaxableIncome. Remember that typing a blank
or hyphen (dash) to separate words, such as Taxable-income or Taxable Income,
will result in a syntax error. Finally, notice that we are using a natural name for taxable
income rather than a cryptic phrase such as TXT, Txi, or T_X_1I. An important rule in
writing algorithms and in naming identifiers is to use natural names. Although they may
take longer to type, they are easier to remember than cryptic names, and they allow for
better program documentation.

The program heading can also be represented by the following statement:
program Program_Name (input, output) ;. The two words input and
output are referred to as program parameters. For some Pascal translators they are
required even when standard input (the keyboard) is used for entering data and when
standard output (the screen) is used for displaying data. In both Macintosh Pascal and
THINK Pascal, this form is optional when writing programs.
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Following the program statement is the uses clause. Uses was first introduced in
the UCSD p-System. This statement directs the Pascal interpreter to find and include the
libraries contained in the list of names that follow the reserved word uses. Although
this clause is not always required, it allows special, predeclared constants, types, and
programs to be borrowed from one or more library units and included within a Pascal
program. A library or library unit contains a collection of special, predeclared objects and
programs that a program can borrow. The uses clause is particularly important when
writing THINK Pascal programs (as compared to Macintosh Pascal). A THINK Pascal
program can borrow from more than 56 Macintosh libraries. An additional 36 libraries
can be referenced without the uses clause, since they are built into THINK Pascal. In
Macintosh Pascal, only three libraries can be referenced by the uses clause:
QuickDraw1, QuickDraw2, and SANE.

After the program heading and the uses clause, the Pascal program may contain
constant, type, and variable declarations. These statements list any
constants, programmer-defined types, and variables to be encountered in the program.
They begin with the reserved words const, type, and var. The executable portion
of the program is enclosed between the reserved words begin and end. Notice that a
period is required to terminate the last end of a Pascal program. Statements enclosed in
special braces { } are comments and have no effect on the execution of the program.!
However, the comments can be important to those reading the program or in documenting
the program for future reference.

In Chapter 1 we listed a program named Circle, an example of a simple Pascal
program. Its purpose is to "paint” a circle in the Drawing window by executing the code
listed in the program window. Figure 3.2 gives the Macintosh Pascal listing for the
program.

Taking the program line by line, we see the following:

1. The program heading identifies the title of the program as Circle. Since no
parameters or uses clause are necessary, that portion of the program heading is
omitted. The line ends with a semicolon as required.

2. The next line in the program is a comment line identifying the declarations
section of the program. Three constants are declared under the keyword const.
They define the circle to be painted. The center of the circle is located by its x
and y coordinates, named Width and Height and assigned the values of 40 and
50, respectively. Next the radius of the circle is set as a constant called Radius
and assigned a value of 30. Each of the constant declarations is followed by a
semicolon. These constants, Width, Height, and Radius, are three
identifiers in our program.

3. The body of the program consists of two additional comments and the command
PaintCircle, which directs the machine to draw the circle. The information
necessary for painting the circle comes from the three arguments, Width,
Height, and Radius, separated by commas and enclosed in parentheses.

4. This statement, along with comments, is bracketed between the two reserved
words begin and end. This represents the executable body of the program.

1 In THINK Pascal, compiler directives can be inserted between comment brackets. By
inserting these special strings between comment brackets the programmer may direct the
compiler to generate different machine code than it normally would.
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E[==—— Example2.| —r——==

program Circle(input, output); Q
{ Declarations section. }
const
Width = 40;
Height = 50;
Radius = 30;
begin
{ Working part of the program. }
{ Draw a circle in Drawing window. }
PaintCircle(width, height, radius) [ |
end. g
)

Figure 3.2 The Macintosh Pascal version of Circle.

3.3 THE CONCEPT OF A DATA OBJECT

Figure 3.3 outlines the key features of a data object. As the illustration shows, a data
object can be either a constant or a variable. It consists of an identifier associated with a
name, one or more attributes (properties), and a value. The properties or attributes of the
data object depend on its type. Variation in data types is one of the main sources of
richness in Pascal. We will discuss some of the alternative types in detail in a later
section of this chapter.

3.3.1 Constants

A constant is a data object whose value remains unchanged throughout the execution of a
Pascal program. Constants in Pascal are of two types. The first is a constant declared at
the beginning of a program, using the following syntactical format:

const
Name_1 = value_1;
Name_2 = value_2;
Name_n = value_n;
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Identifier Constant
Variable

( associated with )

Name Value

Property or
Attribute

Figure 3.3 The concept of a data object.

Here a named identifier is associated with a value on the right. This value can be a
number, a predeclared constant already known to Macintosh Pascal, or the name of a
another constant previously declared. It cannot be an expression. The equal sign in the
constant expression represents an equality between the name on the left and the value to
its right. When the Pascal program is translated from Pascal to machine code, everywhere
that the name of the constant appears, it is replaced by its equivalent value. It is a data
object at the level of the Pascal language, since it has both a name and a value. The
attribute associated with the constant is given by the attribute associated with the value of
the constant. For example, the program Circle has three constants defined as follows:

Height = 50;
wWidth = 40;
Radius = 30;

Each constant is of type integer, since each value is written as a whole number, an
integer.

Although the Macintosh Pascal syntax rules do not allow the value of a constant to
be an expression, a constant can be equated with the name of another constant. Some
examples showing values for constants as well as variations in writing the declarations
follow:

const
Max = 120.0;
Min = - Max;
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Truth = true;

Nontruth = false;

Message = 'This is a string.';
Character_Const = 'A';

THINK Pascal syntax rules do allow the value of a constant to be an expression. For
example, the program Test, listed below, will execute in THINK Pascal, causing the
value of the variable C to be written as 50. An attempt to execute the same program under
Macintosh Pascal will cause a syntax error, as shown in Figure 3.4.

@9 This statement or keyword doesn't belong here.

Test.Mac

program Test(input,output);
const
A =5;
B =10;
P c-=A*B;
begin
ShowText;
writeln('C = ', C);
end.

o

=<l

>

Figure 3.4 The program Test after attempted execution under Macintosh Pascal.

Program Test (input, output);
const

A
B
C

begin
ShowText ;
writeln(‘C = ',C);
end.

noun
'_\
o ~

In addition to multiplication, the other standard operators (+, -, /, div, and mod) can
be included in the constant expressions of a THINK Pascal program.
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The reserved word const can be repeated several times when declaring constants;
for example,
const
Max = 120.0;
Min = - Max;
const
Truth = true;
Nontruth = false;
const
Message = 'This is a string.';
Character = 'A';
The second kind of constant found in Pascal programs is an explicit value used
within an expression in an executable statement. This kind of constant is not given a
name. As an example, consider the following Pascal statement from the program
Electric_Bill:
Average_Consumption := Total_Consumption / 12;

In this statement the slash (/) represents division, while the characters s = represent the
action of assigning a value to a data object. When executed, this statement will result in
the value of Total_Consumption being divided by 12 and assigned to the object
called Average_Consumption. The 12 is a constant with no previous declaration and
has no association with an identifier. Although this constant has no name, it assumes the
properties of an integer type due to its format (12 as compared with 12.0).

Both THINK Pascal and Macintosh Pascal have a number of built-in constants for
reference. These include pi (3.141592653589793239), true, false, maxint
(32,767, or 215-1), and maxlongint (2,147,483,647, or 231-1). These constants may be
incorporated in a program without previous declaration, since they are understood by the
Pascal software.

Real constants in Pascal must be represented by at least one digit preceding the
decimal point and at least one digit following the decimal point.

3.3.2 Variables

var

A variable is a data object whose value can be changed during the execution of a program.
Variables are declared after constants and types by using the following syntactical form:

Name_1 : datatype;
Name_2 : datatype;

Name_n : datatype;

Here the word var is reserved for declaring data objects to be variables. As with
declaring constants, the reserved word var can be repeated several times when writing
variable declarations. The rules for naming variables are the same as those for any
identifier. In addition, however, it is wise to select variable names that are meaningful.
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var

Cryptic variable names can make a program difficult to read, especially if it has been left
to sit idle for several months. Following are some examples of variable declarations:

Max_Value : integer;

Interest : real;

Debt, Balance, Income : real;
Months, Days : integer;

Notice that you are allowed to list several names, separated by commas, on the same
line if they are of the same data type. For example, Debt, Balance, and Income are
all declared to be real data types and are listed together.

A variable satisfies the properties of a data object; it has a name, an attribute given
by an explicit declaration of a data type, and a value that can only be assigned during the
execution of a program. Values are given to variables only through the execution of an
assignment or input statement. In memory a variable can require one or more cells to
store its value, depending on the attribute (data type) associated with the variable. This is
different from a constant, which never requires explicit memory cells for storing its value.
At this level of the machine, the name of a variable represents an address where the value
of the variable is stored. When a new value for the variable is entered from the keyboard,
or when a new value is assigned to the variable by an assignment statement, the value
that is presently stored is lost, and the new value is assigned. In other words, the new
value is written over the old value. When the value of a variable is needed for
computation, it is copied from memory and used. The value presently stored for the
variable remains unchanged by this process.

The program Sample_Program, shown in Figure 3.5, illustrates the use of a
variable. The program declares two variables named First_Variable and
Second_Variable in the declarations. The executable portion of the program consists
of writeln commands used for displaying messages and the values of the variables to
the Text window. The program is divided into three sections for ease of reading. In the
first section, values of each of the two variables are displayed prior to assignment of a
value by the programmer, as shown in the Text window in the first line. This raises an
important point. All numeric variables in either THINK or Macintosh Pascal have a value
of zero when execution begins.2

In the second section of Sample_Program, a value of 10 is assigned to
First_Variable, and a value of First_Variable + 20to Second_
Variable. Line 2 in the Text window displays these values. Finally, the value of
First_vVariable is changed to 50 in order to illustrate that the number contained in
its memory cell may be changed. The third line displayed in the Text window confirms
this change. (Notice that the value of Second_Variable still reflects the first value
assigned to First_Variable, since nothing has been done to change the value of
Second_Variable.)

2 It is not good programming practice to depend upon this initial value. If you want a variable
to begin with a value of zero, you should initialize it to that value as a part of your program.
This practice was illustrated in the program Electric_Bill.
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E[[==———= Sample_Program
program Sample_Program(input, output);
var
First_Variable, Second_Variable: integer;
begin
ShowText;

{1. Display values of variables before }
{ assignment is made. }
writeln('l-- ', First_Variable, Second_Variable);

{2. Assign values to variables and display. }

First_Variable := 10;
Second_Variable := First_Variable + 20;
writeln('2-- ', First_Variable, Second_Variable);

{3. Reassign the value of First_Variable and }
{ display the results. }

First_Variable := 50;
writeln('3-- ', First_Variable, Second_variable)
end.
Em———— 5
1-- 0 0
2-- 10 30
3-- 50 30

Figure 3.5 Sample_Program and its output.

Now that we have introduced the concepts of constants and variables, let us illustrate their
use in another program, Large_X. This program uses the PaintCircle command in
a new way. By drawing many circles, each with a different center location, the command
PaintCircle becomes a brush for drawing a large X in the Drawing window. Figure
3.6 shows both the program and its result. In order to keep this example simple, we
employ a special control construct, the £or statement, which we will discuss in detail
later. For now you need only know that this statement allows us to change the value of a
variable repeatedly during the execution of a program. The change is over a range specified
in the statement. In this example we change the value of the variable Countexr from 200
to 0. Thus we begin the process with the value of Counter set at 200, drawing the
circle with the following arguments of the command PaintCircle:

PaintCircle(200,200,10);

The value of Counter is then changed by the £or statement to 199, so that the
arguments of the command PaintCircle are
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B e Large_X

program Large_X(input, output);
{ Use PaintCircle to draw a large X . }

const
Radius = 10;
var
Counter: integer;
begin

ShowDrawing;
{ Repeatedly change the center of the }
{ circle until a large X has been drawn. }
for Counter := 200 downto 0 do
{ Draw first diagonal. }
PaintCircle(Counter, Counter, Radius);
for Counter := 200 downto 0 do
{ Draw second diagonal. }
PaintCircle(200 - Counter, Counter, Radius);

end

EDE Drawing ==L

&l

Figure 3.6 The program Large_X and its output.

PaintCircle(199,199,10);

This process continues until the value of Counter becomes 0, and the command
PaintCircle has the following arguments:
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PaintCircle(0, 0,10);

At this stage of the program, the first diagonal of the large X has been drawn, and the
second £or statement is encountered. This statement repeats the above process, except
that the first argument of the command PaintCircle, representing the horizontal
position, is now 200 — Counter. Thus the progression becomes

PaintCircle (0, 200, 10);
PaintCircle(l, 199, 10);

PaintCircle (199, 1, 10);
PaintCircle (200, 0, 10);

Large_X illustrates the power of the variable—the ability to change the value
(contents of the memory cell) of a variable as the program is being executed. We could
have drawn the X displayed by Large_X without using a variable by typing the
PaintCircle command several hundred times, changing the arguments each time.
Obviously, using the variable Counter and the for command results in a more efficient
program.

3.4 INPUT AND OUTPUT

It is hard to imagine computer programs without the ability to input and output
information. Many programs would be useless if you could not input the specific values
that concern you. For example, a program that computes payments for a loan would be of
little use if it only allowed an interest rate of 10%. If you wanted to know the payments
required to finance a new car, with an interest rate of 8%, you would need a new program.
More new programs would be needed each time the interest rate changed in the future.
Likewise, regardless of the sophistication of the program, it would be useless if you could
not obtain its results in some form of output. To illustrate this point, try executing a
Pascal program that produces text output with the Text window closed. In Pascal, output
commands are given as write and writeln, and input commands are given as read
and readln. You have already seen examples of how to use these commands, but a
closer examination of each command is desirable. As you will see, some of the differences
between write and writeln and read and readln are very subtle.

3.4.1 Output in a Pascal Program

Write and writeln are standard Pascal commands for directing the output from a
program to the Text window.3 As you have seen, you can use these statements to display

3 With THINK Pascal you must always include the command ShowText as part of your program
to display the Text window. Failure to do so will make the write and writeln commands
useless, since you will be unable to see the result. This command is unnecessary with
Macintosh Pascal, because the Text window is automatically displayed, unless another
command is used to prevent it.
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messages (prompts), values associated with data objects, or both. Write is an executable
statement having the following form:

write( par_1l, par_ 2, . . . , par_n );
where par_1, par_2, . . ., par_n are referred to as parameters and can be constants,
variables, or expressions. When this statement is executed, the value of each parameter is
displayed in the Text window, starting with the value of the first parameter on the left and
ending with the last parameter on the right. For example, the statement

write( A, B, A + C );
begins execution by first displaying the value for variable A, followed by the value for
variable B, followed by the value for the expression A + C. This statement could also be
written as three write statements:

write( A );

write( B );

write( A + C );

A write statement does not terminate a display; the next write orwriteln
statement that is executed will continue to display data along the same line. This is a
useful feature if you want a horizontal display of values.
Writeln is also an executable statement having the following form:

writeln( par_1, par_2, . . . , par_n );
This command differs from the write command in that the display line is terminated
after a writeln is executed. Execution of the next write or writeln statement
displays data on a new display line. For example, the statement

writeln( A, B, A + C );
which is equivalent to

write( A );

write( B );

writeln( A + C );

will display the values of A, B, and A + C on one line. The following three writeln
statements will display each of their parameters on separate display lines:

writeln( A );
writeln( B );
writeln( A + C );

The unadorned statement

writeln;



76 Chapter 3  Constants, Variables, and Simple Input and Output

can be used to terminate a display line as well as to display a blank line. For example, the
following statements cause one blank line appear between each of the three values
displayed in the Text window:

writeln(' Value of A: ', A );
writeln;
writeln(' Value of B: '; B );
writeln;

On the other hand, the statement
write;

is equivalent to displaying a null character, a character having no image and no length. In
brief, this statement has no effect on output. The statements writeln() and write()
are syntactically incorrect in both Macintosh Pascal and THINK Pascal. Either statement
will cause an error message when the program is checked.

The following program, Display_Text, illustrates the use of these two
commands with emphasis on their differences. The program is divided into segments in
order to simplify the discussion. (Segments are separated by comments.)

program Display_Text (input, output);

{ Purpose: Introduction to the write and writeln statements. }
var

{ Declare two "typical" numeric variables. }

First_Variable : integer;
Second_Variable : real;

begin
ShowText ;

{ Provide a heading for the display. }
writeln('Part Output');

{ Assign values to the variables. }

First_Variable := 24;
Second_Variable:= 23.56;

{ 1. Display the values of the two variables. }
write('l', First_Variable);
writeln(Second_Variable) ;

{ 2. Clean up the format of the second variable. }
write('2', First_Variable);
writeln(Second_Variable : 5 : 2);

{ 3. Separate the variables in the display. }
write('3', First_Variable, ' ');
writeln(Second_Variable : 5 : 2);

{ 4. Displaying a message in the output. }
writeln('4', ', 'Place your message here');

{ 5. Displaying text and variable values together. }
write('5', First_Variable, ' or here ');
write(Second_Variable : 5 : 2);
writeln

end.
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Consider each of these segments separately. First, the program heading consists of
the identifier, Display_Text, followed by the declaration of two numeric variables: an
integer variable called First_Variable and a real variable called
Second_Variable. The standard ShowText command insures that the THINK Pascal
user can see the results.

Second, there is a segment that produces a heading for the display. This consists of
the command writeln('Part Output'). As you can see in Figure 3.7, the
material within the single quotes is printed exactly as it appears in the program. This
includes the blank spaces between the words Part and Output, which are included to
align the headings with the remainder of the display. Usually the programmer uses trial
and error to determine the exact number of blank spaces to include.

E[I==—= Text =015

Part  Output

24 2.4e+1

2423.56

24 23.56

Place your message here
24 or here 23.56

abh O =

Figure 3.7 The output from Display_Text.

Third, there is a section in which the variables are assigned their initial values. The
assignment is achieved with the Pascal symbol :=, which we read as “becomes.” For
example, “First_Variable becomes 24.”

Fourth, the assigned values of the two variables are printed. To help you follow the
discussion, the number 1 is included in the display, preceding the display of the values 24
and 2.4e+1. Notice the use of the write command rather than the writeln command,
which we used previously. This allows the values of both variables to be printed on the
same display line.

There are two problems with the display from Section 1 of the program. First, the
value of Second_Variable is displayed in the form of scientific notation (which is
not comfortable for many people and also loses detail, as 23.56 is reported as 2.4e+1).
Second, the two values are displayed as one stream of digits with no space between them,
making the display difficult to read.

Fifth, in Section 2 of the program, the scientific notation is removed by means of
the format : 5 : 2 inthe command writeln(Second_Variable : 5 : 2).
The first of these format numbers (5) gives the minimum size (minimum number of
characters including digits, sign, and decimal point) of the field to be occupied by
Second_Variable. Since the value assigned to Second_Variable is 23.56, the
size of the field must be at least five (four digits and a decimal point). If you specify too
few spaces, the Pascal system will produce the necessary additional space for displaying
the new value. Thus the command writeln(Second_Variable : 3 : 2),
would result in the same display. The second format number (2) indicates the number of
digits to be displayed to the right of the decimal point. The output from this segment of
Display_Text is labeled 2 in Figure 3.7.
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Sixth, we solve the problem of the values of the variables, 24 and 23.56, being
displayed in one stream (that is, without any separation). This is done by including a
space (a blank enclosed within single quotes) in the command

write('3', First_Variable,' ');
write(Second_Variable : 5: 2);

The space following First_Variable will cause the two numbers to be separated, as
shown in Line 3 of the output display. The same effect can be achieved with the single
statement

write('3', First_Variable, Second_Variable : 6: 2);

where the overall length of the field for the real variable, Second_variable, is
enlarged to allow a preceding blank space.

Seventh, as shown in Line 4 of the display, a text message may be included in the
output. This may be a straightforward message, as shown in Line 4, or it may be
integrated with the variable output, as shown in Line 5. The entire output of Display_
Text is shown in Figure 3.7.

Remember the following guidelines when using the write and writeln
commands. Use the write command if you want to continue displaying output on the
current line appearing in the Text window. Use the writeln command if you want to
display output on a new line in the Text window. To display the value of a real-type
variable, indicate the overall size of the field and the number of places desired after the
decimal point. Any messages to be included in the display should be contained in single
quotes. If more than one variable is included in a write orwriteln statement,
commas are required to separate the list of items. Use trial and error to obtain a display
with a pleasing appearance.

3.4.2 Input in a Pascal Program

Read and readln commands are standard Pascal input commands for entering data into
a Pascal program. When executed, either command will cause the Macintosh computer to
pause and accept input from the keyboard.

The read and readln commands are executable statements having the following

forms:
read( variable_1, variable_2, . . . , variable_n );
readln( variable_1, variable_2, . . . , variable_n );
where variable_1, variable_2, . . . , variable_n are the names of

previously declared variables. When executed, each statement will halt execution until the
values of all variables have been typed, and the Return key has been pressed.

The relationship between read and readln is similar to the relationship
between write and writeln. After execution of a read statement, execution of a
read, readln, write,orwriteln command will continue to display data on
the same line. A readln command terminates the display line after all variables have
been entered. A new line will be displayed when the next input or output command is
executed. Whereas the statement read; has no effect on either input or output, the
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statement readln; can be used to terminate a display line after input has been entered.
For example, the statement

readln( A, B, C );
can be replaced by either of the following sets of commands

read( A, B, C );
readln;

or

read( A, B, C );
writeln;

The statements read () and readln () are not understood by either THINK Pascal
or Macintosh Pascal and will cause syntax errors. Figure 3.8 shows a program that
demonstrates the difference between read and readln. Titled Demonstrate_
Input_1, this program accepts input for two variables and then displays their values to
the Text window. In this example, the Return key must be pressed after each value is
entered. Notice that in the top portion of Figure 3.8, the data displayed in the Text
window is somewhat confusing because the input (4 and 12) and output (A = 4andB =
12) were not well controlled by the programmer. Figure 3.9 shows the same output after
one read command has been replaced by a readln command, and one write
command has been replaced by a writeln command. As the figure shows, the readln
and writeln commands terminate the display lines, eliminating the confusion. You
should be aware that the difference between read and readln shown here is not seen if
Demonstrate_Input_1 is executed as a THINK Pascal program. (Try
Demonstrate_Input_1 under both THINK and Macintosh Pascal to observe this
difference.) Thus, with THINK Pascal the programmer has less to control with a read
statement.

As an additional example, let us develop a program for computing the gas mileage
and cost of a trip. For input we have the distance traveled, the total number of gallons
used, and the cost per gallon of gas. For output we will report mileage in miles per
gallon, the total cost, and the cost per mile traveled. The initial steps in our algorithm
follow:

1. Enter the trip data for distance traveled, gallons of gas consumed, and cost per
gallon.

2. Compute the miles per gallon, total cost for the trip, and cost per mile.

3. Output the three values computed in Step 2.

Does our algorithm satisfy all of the characteristics required of a good algorithm?
First, it has a finite number of steps, none of which needs to be repeated. Second, it has
input and output. Third, it is sufficiently simple to be traced by hand. What it lacks is the
property of definiteness. The step for computing the values needed as output is not clear,
nor is it clear in Step 3 what values are to be displayed. The following is a refinement of
our initial algorithm, including comments.
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Demonstrate_Iinput_1

program Demonstrate_Input_1 (input, output);
{ Demonstration of the read/readin command. }
var
A,B : integer;
begin
ShowText
{ Input data on two variables A and B. }
writeln('Enter two numbers between 1 and 20: ');
read(A);
read(B);
{ Output results. }
write('A = ",A : 3);
write('B = ',B : 3);

end.
= Teit ==Vi———=|
Enter two numbers between 1 and 20: >

4
12A = 4B = 12

i<l

Figure 3.8 A comparison of read and readln, with output
produced by execution of a Macintosh Pascal Program.

Algorithm Trip_Analysis;
{ Prompt user to enter trip data. }
write 'Enter the number of miles you drove : ';
read Distance_Traveled;
write 'Enter the gallons of gasoline used: ';
read Gallons_Used;
write 'Enter the price per gallon for gasoline: ';
read Price_per_Gallon;
{ Compute the miles per gallon, total cost, and cost
per mile.}
Mileage <-- Distance_Traveled/ Gallons_Used;
Total_Cost <-- Price_per_Gallon * Gallons_Used;
Cost_per_Mile <-- Total_Cost / Price_per_Gallon;
{ Output the computed values. }
write Mileage;
write Total_Cost;
write Cost_per_Mile;
{End of algorithm.}



Constants, Variables, and Simple Input and Output  Chapter 3 81

Demonstrate_Iinput_1

program Demonstrate_Input_1 (input, output);
{ Demonstration of the read/readin command. }

var

A,B : integer;

begin

ShowText
{ Input data on two variables A and B. }

writeln('Enter two numbers between 1 and 20: ');

read(A);

readin(B);
{ Output results. }

writeln('A = A : 3);

write('B = ',B : 3);
end.

Em_——- - —  — BCINg=— — — —E=
Enter two numbers between 1 and 20: >
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Figure 3.9 An improved version of Demonstrate_Input_1.

Notice that we have used the commands read and write to indicate input and
output, respectively. The distinction between read and readln, and between write
and writeln is unimportant in the algorithm. We are more concerned with the steps in
solving the problem than with the details of displaying it on the screen. We will consider
the extra formatting needed to prompt the user and display data as we write and test the
program.

The following is the Pascal program for the algorithm Trip_Analysis. Itil-
lustrates the use of both input and output commands.

program Trip_Analysis(input, output);
{ Purpose: Analysis of the cost of a trip and consumption of }
{ gasoline. }
var
Cost_per_Mile, Distance_Traveled, Gallons_Used : real;
Mileage, Price_per_Gallon, Total_Cost: real;
begin
ShowText ;
{ Display output title. }
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writeln;
writeln ('’ Trip Analysis');
writeln;

{ Prompt user to enter trip data. }
write('Enter the number of miles you drove : ');
readln(Distance_Traveled) ;
write('Enter the gallons of gasoline used : ');
readln(Gallons_Used) ;
write('Enter the price per gallon for gasoline : ');
readln(Price_per_Gallon) ;
writeln;

{ Compute the mileage, total cost, and cost per mile. }
Mileage := Distance_Traveled / Gallons_Used;
Total_Cost := Price_per Gallon * Gallons_Used;
Cost_per_Mile := Total_Cost / Distance_Traveled;

{ Output results to the Text window. }
write('Your gas mileage was : ") ;
writeln(Mileage : 4 : 2, ' mpg');
write('Your total fuel cost was : $');
writeln(Total_Cost : 6 : 2);
write('Your cost per mile was : $');
writeln(Cost_per_Mile : 6 : 2)

end.

With the exception of the three lines of calculations and the comments, this program is a
series of read, readln,write,and writeln commands. The output from the
program is shown in Figure 3.10.

=]

Text ==FicF——=015
>

Trip Analysis

Enter the number of miles you drove : 750
Enter the gallons of gasoline used : 42
Enter the price per gallon for gasoline : 1.19

Your gas mileage was : 17.86 mpg
Your total fuel cost was : $ 49.98
Your cost per mile was : $§ 0.07

@<

Figure 3.10 The output from Trip_Analysis.

After the heading Trip_Analysis, three lines are displayed, each of which consists of
a prompt for input and the user’s response to the prompt. The first prompt, Enter the
number of miles you drove:, results from the write command,

write('Enter the number of miles you drove : ');
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This is followed by the readln command, readln (Distance). This command
causes the execution of the program to pause until the user enters a response. By entering
750 and pressing the Return key, the user causes the variable Distance_Traveled to
be assigned the real value 750.0. This approach is repeated for entering values of
Gallons_Usedand Price_per_Gallon.

3.5 SIMPLE DATA TYPES IN MACINTOSH AND THINK PASCAL

Macintosh and THINK Pascal support a variety of data types. In general, these can be
classified as simple (sometimes called scalar) and structured. In this chapter we concentrate
on the former kind; the latter are covered in later chapters. Figure 3.11 shows a breakdown
of simple data types available under Macintosh and THINK Pascal.

I. Real Data Types
A. Real
B. Double
C. Extended
D. Computational
II. Ordinal Data Types
A. Standard
1. Integer
2. Longint (long integer)
3. Char (character)
4. Boolean
B. Nonstandard
1. Enumerated
2. Subrange

Figure 3.11 Classification of simple data types in
Macintosh and THINK Pascal.

The broadest distinction is between real and ordinal data types. Real types
involve real numbers (as opposed to ordinal numbers). These include the types real,
double, extended, and computational. Ordinal data types involve ordinal
numbers. The standard ordinal types are integer, longint (long integer),
char (character), and Boolean. The nonstandard ordinal types are the
enumerated type and the subrange type. We will discuss each of these types in the
following sections.

3.5.1 Real Data Types

In Pascal, a number that includes a decimal point is referred to as a real number.
Examples of real numbers are 0.0093, 1.29, 43.7 and 69500.00. This last number,
69500.00, can also be written as 6.95 * 10* (this is called scientific notation). Since
Pascal cannot handle the superscript in this notation, the number is represented in a
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floating-point notation; that is, the number 69500.00 is written as 6.95E+4 or 6.95e+4.
In this notation the letter E or e represents a factor of 10, and the +4 represents the
exponent. In Pascal, real data types are those that accept floating-point numbers.

The distinction among the real data types real, double, and extended is in
the number of significant digits retained and in the range of values that the numbers can
represent. The approximate limits are given in Figure 3.12.

Real Data Type | Significant Digits Range of Number
Real 7-8 1.5*10% to 3.4*10%
Double 15-16 5.0*103%% to 1.7*10%8
Extended 19-20 1.9*10451 to 1.1*104932
Computational 18-19 92*108  to 9.2*1018

Figure 3.12 A comparison of real data types in Macintosh
and THINK Pascal.

These numbers can be negative as well as positive. The comp (computational) type
differs from the other types in that the number involved must be an integer. (There
can be no decimal fraction and no exponent.) This type is convenient for accounting
applications where exact representation of numbers is desired. When you use this form,
you must add the decimal point to the computed result. For example, in a program
designed to compute interest earned, all of the computations would be based on measuring
the results in pennies; conversion to dollars and cents would be the responsibility of the
programmer. In both Macintosh and THINK Pascal, each of the real types is converted
to extended mode when real arithmetic operations are performed.

The program Real_Numbers illustrates the differences among these types. This
program takes advantage of the endless string of digits produced when certain fractions are
expressed as decimal numbers. Since a computer can only approximate this endless string,
the results displayed by the program show the accuracy of the approximation with each of
the different real data types. The listing for the program Real_Numbers follows.

program Real_Numbers (input, output);
{ Purpose: Demonstrate variations on real numbers. }
const
Numerator = 1;
Denominator = 3;
var
First: real;
Second: double;
Third: extended;
Fourth: computational;
begin
ShowText ;
{ Write 1/3 as four different types of real numbers. }
First := Numerator / Denominator;
Second := Numerator / Denominator;
Third := Numerator / Denominator;
Fourth := Numerator / Denominator;




Constants, Variables, and Simple Input and Output  Chapter 3 85

writeln;
writeln('Fraction = ', Numerator : 2, '/', Denominator : 1);
writeln;

writeln('real

writeln('extended

First : 22 : 20);

Third : 22 : 20);

writeln('double ', Second : 22 : 20);

writeln('computational

end.

Fourth : 22 : 20);

First

Second :

Third

Fourth :

Four variables are declared: one real, one double, one extended, and one
computational. Each of these variables is assigned the value of 1/3 within the body
of the program, with the result being displayed. The results of the execution of this
program are given in Figure 3.13.

E[I————= Text =]

3

Fraction = 1/3

real 0.33333334326744079590
double 0.33333333333333331480
extended 0.33333333333333333330
computational 0.00000000000000000000

=]k

Figure 3.13 Output from Real_Numbers with the
fraction 1/3.

As you can see, the different data types produce distinctly different results. The real
type produces a string of seven 3s. With the double type, the length of the string is 16.
With the extended type, the string contains nineteen 3s. The computational type
produces no 3s, since this type can only represent integer numbers.

This can be more clearly demonstrated by using other fractions as values and by
making the ratio greater than 1 in order to allow the computational type to be
included in the comparison. We achieve the latter step by scaling each of the numerators
as follows:

(Numerator
(Numerator
(Numerator
(Numerator

Scalefactor) / Denominator;
Scalefactor) / Denominator;
Scalefactor) / Denominator;
Scalefactor) / Denominator;

* * % *

where Scalefactor is a constant assigned a value of 100600000000000000000 or 1.0
* 10'9. Figure 3.14 shows the output after these changes for two additional fractions,
23/37 and 8/17. In both cases the differences between real and double and between
double and extended are readily apparent.

When reading a value for a variable that is of type real, double, extended, or
computational, characters are scanned from left to right. Both the read and
readln statements will skip all blanks and end-of-lines (returns) that precede the digits
of a real number. On reaching a proper digit, the read statement will continue to read
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the sequence of digits and other characters that form a proper signed real number. The
first nondigit encountered terminates the entry of a real value. A nondigit can be a
blank, a return, or some other character such as a letter of the alphabet. Consider the
following example where A is a real type:

readln( A );

=== Text

Bl

Fraction = 8/17

real 4705882279090585600.00
double 4705882352941176832.00
extended 4705882352941176470.00

computational 4705882352941176470.00

[E[J=——— Text

D] B

Fraction = 23/37

real 6216215981224624128.00
double 6216216216216216576.00
extended 6216216216216216216.00

computational 6216216216216216216.00

¥

=

Figure 3.14 Output from Real_Numbers (modified) with the
fractions 8/17 and 23/37.

If you type the characters:
~12.345This is a real number

the variable A will become ~12.345. Input terminates on seeing the character T, since
this is a nondigit in a real number. In addition, because this is a readln command
instead of a read statement, the input line is terminated. Any additional input following
this command is assumed to begin on a new line.

3.5.2 ordinal Data Types: Standard

The term ordinal implies a specified position in a numbered series or order. Standard
ordinal data types include integer, longint, char, and Boolean. Integer
and longint data types have values within a specified set of integers. For
Macintosh and THINK Pascal, these sets have the limits given in Figure 3.15. In
Macintosh Pascal, integer values are automatically converted to longint values when
integer arithmetic operations are performed.
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Data Type Largest Allowed Smallest Allowed
Integer 32767 -32767
Longint 2147483647 -2147483647

Figure 3.15 A comparison of the limits of the two integer data types.

To understand why longint is important, consider the program Second_
Counter for converting the time of day as input into seconds. The program computes
and reports the number of seconds that have elapsed between midnight and the time of day
specified on input.

program Second_Counter (input, output);

{ Purpose: Program for converting hours and minutes to seconds }

{ as an integer value. }
const

Length_of_Hour = 3600;
Length_of_Minute = 60;
var
Hours, Minutes, Seconds, Elapsed : integer;
begin
ShowText ;

{ Enter a time--no traps, so use care. }
writeln('Enter the exact time as prompted--');
writeln('use international time ');
writeln;
write('Hour ?');
readln (Hours) ;
write('Minute ?');
readln (Minutes) ;
write('Second ?');
readln (Seconds) ;

{ Compute seconds elapsed since midnight. }

Elapsed := Hours * Length_of_Hour + Minutes * Length_of_Minute
+ Seconds;

writeln;

writeln('The number of seconds which have ');

writeln('elapsed since midnight is ', Elapsed : 2, '.');
end.

The program converts hours and minutes to seconds and adds the results. An
interesting feature is that the program will execute only if the time of day is 09:06.07
AM. or earlier. Any later time will cause the program to fail due to overflow error.# The
program is unable to continue execution because the value of the integer variable

4 The THINK Pascal version of the program will fail and report an overflow error only if you
have activated the overflow checking option for the file Second_Counter in your
project window. If this option is not active, a time of 9:06:08 or later will result in a
negative number. Although with a little mathematical manipulation you could produce a
correct result using this negative number, it is hardly an acceptable result.
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called Elapsed exceeds the maximum size of an integer variable (32,767). Changing
the statement

Hours, Minutes, Seconds, Elapsed : integer;

to

Hours, Minutes, Seconds, Elapsed : longint;

allows the program to execute with larger integer numbers and to operate with any
legitimate time of day.

When reading a value for a variable that is of type integer or longint, char-
acters are scanned from left to right. Both the read or readln statements will skip all
blanks and end-of-lines (returns) that precede the digits of an integer number. On reaching
a proper digit, the read statement will continue to read the sequence of digits and other
characters that form a proper signed integer number. The first nondigit encountered
terminates the entry of an integer value.

The ordinal data type, char, has a set of integral values that relate to the
character set of the Macintosh. For example, the character A has an integer value of 65
(decimal). This number is also called its ASCII value and can be produced with the
function ord (X) . The function ord returns the position (ordinal number) for argument
X, which must be an ordinal type such as integer, longint, char, or
Boolean. A complete list of ASCII characters is given in Appendix C. For example,
the program Keyboard, shown in Figure 3.16, makes use of a char-type variable.
This program prompts the user to type a character from the keyboard. The computer then
displays the ordinal value of the character. For the present, ignore the new commands
repeat and until; they are explained in Chapter 5. The program continues to
execute until the lowercase z key is pressed. The heart of the program is the function
ord (Key), where Key is a variable declared to be of the ordinal type char.

An identifier having the data type Boolean has an ordinal value of false or
true. The values false and true have ordinality, just like any other ordinal data
type. Specifically, the ordinal value of false is 0 and the ordinal value of true is 1.
What makes this data type unique is the limited range of its values. For example, consider
the program Truth_Table, where Boolean variables are used to display a truth table.
The result is a table similar to the one in Figure 3.17.

This table and the program that produces it show how Boolean variables are used
with the Boolean operations and and ox. The operation One and Two results in a
value that is true if both values of variables One and Two are true. If one or both are
false, the result of One and Two is false. The operation One oxr Two is true if
one or both of the values of variables One and Two are true. If both values are false,
the result of One or Two is false.
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Keyboard

program Keyboard(input, output);
{ A program to return the ordinal value of the various keys. }
var
Key : char;
begin
ShowText
repeat
{ Select a key and return its ordinal (ASCII) value. }
write('Press a key. ');
readin(Key);
{ Write the value of the key pressed. }
writeln('The ordinal value of this key is ', ord(Key), '.");
{ Repeat this cycle until the key "z" is pressed. }
until (ord(Key) = 22);
end.

[[E=———— Texut

Press a key. a
The ordinal value of this key is 97.

BlE

Press a key.

(E]%e]

Figure 3.16 The program Keyboard and its output.

Line Variable Operation
One Two or and
1 True True True True
2 Trur False True False
3 False True True False
4 False False False False

Figure 3.17 A truth table based on Boolean variables.

89

program Truth_Table(input, output);
{ Purpose: demonstration of a Boolean data type. }

var
{ Declare two Boolean variables. }
One, Two : Boolean;
begin

{ Display table headings. }
writeln('Line Variable Operation');
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writeln (' One Two
{ Assign values for line 1. }
One := true;

Two := true;
{ Display table line 1 .}

writeln('l ', One: 8, Two: 8, One or Two:

{ Assign values for line 2. }
One := true;
Two := false;
{ Display table line 2 .}
writeln('2 ', One: 8, Two: 8,
{ Assign values for line 3 . }
One := false;
Two := true;
{ Display table line 3 .}
writeln('3 ', One: 8, Two: 8,
{ Assign values for line 4 . }
One := false;
Two := false;
{ Display table line 4 . }
writeln('4 ', One: 8, Two: 8,
end.

norll u andll 1 ) :

One or Two:

One or Two:

One or Two:

8, One and Two: 8);

8, One and Two: 8);

8, One and Two: 8);

8, One and Two: 8);

There are three important Macintosh functions that operate with any ordinal data

type:

ord(X) : This function takes as its argument an ordinal type represented by X
and returns the ordinal position of this argument.

pred(X) : This function takes as its argument an ordinal type represented by X
and returns the ordinal predecessor of the argument.

succ (X) : This function takes as its argument an ordinal type represented by X
and returns the ordinal successor of the argument.

The first value in any ordinal set has no predecessor. Using the function pred under
this circumstance will cause an error at the time of execution. Thus the expression
pred(true) with a Boolean variable returns a value of 0 (the ordinality of the value
false), while the expression pred (false) causes an error since false is the first
true(1l)]. Likewise, the last value in this
same ordinal set has no successor. The program Ordinal_Functions, shown in
Figure 3.18, illustrates how to use these standard functions.

Three variables are declared in the program; two Boolean variables called One and
Two and an enumerated variable called Class. (Enumerated variables are
explained in Section 2.5.3.) These variables are assigned values as follows:

value in this ordinal set [ false(0),

One false;
Two true;
Class := Second;
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Ordinal_Functions
program Ordinal_Functions(input, output);
{ A brief demonstration of the functions succ, pred, and ord. }

var
=== Texnt ==

One, Two: boolean;

begin Class: (First, Second, Third); function variable Q_
One Two Class
ShowText;
{ Assign values to variables. } ord 0 1 1
One := False; pred none FALSE First |—
Two := True; succ TRUE none Third 9’_
Class := Second; .y
{ Demonstration of functions. }
writeln(‘function variable');
writeIn(' One Two Class');
writeln;
writeln(‘ord', ' ', ord(One), ord(Two), ord(Class));
writeln('pred ', 'none', ' ', pred(Two), ' ', pred(Class));
writeln(‘succ ', succ(One), ' ', 'none’, ' ', succ(class));
end.

Figure 3.18 The program Ordinal_Functions and its output.

The three ordinal functions are then applied to each of the variables, and the results
are printed in a table. Notice that the cases that would cause a failure of the program are
omitted, with the word none substituted in the table. For example, pred (One) is not
included. Since the variable One has a value of false (with an ordinality of 0), it has
no predecessor. Likewise, succ (Two) is omitted, since Two has a value of true,
which has no successor. The variable Class produces a value for all three functions, but
only because we assigned it a value from the middle of the range (Second).

3.5.3 ordinal Data Types: Nonstandard

In addition to these standard ordinal data types, there are two nonstandard types: the
enumerated data type and the subrange data type. The term enumerated means to
count off, name one by one, or list as a group. The following declaration shows some
examples of the enumerated data type:
var
Month : ( Jan, Feb, Mar, Apr, May, Jun, Jul, Aug,,Sep, Oct,
Nov, Dec );
Days_of_Week : ( Sunday, Monday, Tuesday, Wednesday, Thursday,
Friday, Saturday );
First_Names : ( Rose, Mary, John, Paul, Sue, Fred, Bill );
Alphabet : (A, B, C, D, E, F, G, H, I, J, K, L, M, N, O, P,
Q, R, s, T, U V, W X, Y, 2);
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In this example we have declared the variables Month, Days_of_Week,
First_Names, and Alphabet to be of type enumerated. These declarations
indicate the possible values that each of the variables can be assigned. Through the
execution of a read, readln, or assignment statement, a value can be assigned to any
of our enumerated variables. The items in each list, such as (Jan, Feb, Mar,
Apr, May, Jun, Jul, Aug, Sep, Oct, Nov, Dec), have ordinal values related
to their position in the enumerated list. For example, ord (Jan) is equal to O since
Jan is first in the declaration list, while ord (Oct) is equal to 9. The other functions of
the ordinal data type, pred and succ, also apply. For example, pred (Mar) is
equal to Feb, and succ (Mar) is equal to Apr.

The following program, called Date, was designed around an enumerated type
representing the month of the year.

program Date (input, output);
var
Month : (Jan, Feb, Mar, Apr, May, Jun, Jul, Aug, Sep, Oct,
Nov, Dec) ;
Day, Year : integer;
Slash : char;
begin
ShowText;
{ Prompt the user for todays date. }
writeln(' Enter todays date using the following ');
writeln(' format: month/day/year, where month');
writeln(' is written as three characters, day as');
writeln(' a whole number, and year as the last two');
write(' digits of the current year: ');
readln(Month, Slash, Day, Slash, Year);
writeln;
{ Display today's date in the following format: }
{ Month - Day - 19 _ _ . }
write('Todays Date : ');
writeln(ord(Month) + 1 : 2, ' - ', Day : 2, ' - ', '19', Year
2);
end.

In this program we enter a date given in the form month/day/year, where month is
represented by three characters, day is a two-digit number, and year is the last two digits
for any year in the current century. Notice that the input statement

readln( Month, Slash, Day, Slash, Year );

reads a single character after it has read the enumerated value for Month and again

reads a single character after it has read a value for Day. This simply provides a way to

dispose of the slash on input. The program then displays the same date in the form

"Month - Day - 19 _ _ " using the following output statement:

writeln(ord(Month) + 1 : 2, ' - ', Day : 2, ' - ', '19', Year
2 );
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where Month is now represented by 1 plus the ordinal value of the variable Month.
Why add 1 to this ordinal value? Remember that the ordinals of the enumerated values
Jan through Dec are 0 through 11, respectively. The addition is necessary to correct for
the proper numeric value of Month in relation to presenting the date. Figure 3.19 shows
the output from Date.

[I==————Text E=——1

Enter todays date using the following
format: month/day.year, where month

is written as three characters, day as

a whole number, and year as the last two
digits of the current year:
Jul 24 91

Todays Date : 7 - 24 - 1991

Q<

Figure 3.19 Output from the program Date.

Next, we show another short program called Enumerated_Type. This program
reveals the difference between an enumerated type representing the letters of the
alphabet A through Z and the standard ordinal type, char. Here the letter H has been
entered twice. It is assigned to the variable Letter_1 and a second time to the variable
Letter_2. The result of executing Enumerated_Type is shown in Figure 3.20.

The ordinal value of H when assigned to variable Letter_1 is 7, since it represents
the eighth character from the left in the enumerated declaration of Letter_1. Its
ordinal value when assigned to variable Letter_2 is 72, since it now represents the
73rd character in the ASCII character set supported by Macintosh and THINK Pascal.
Even though these two variables are assigned values that are letters from the alphabet,
they have completely different data types and are completely incompatible with each
other.

program Enumerated_Type(input, output);
{ Purpose: demonstration of enumerated and ordinal data types. }

var
Letter_1 : (A, B, C, D, E, F, G, H, I, J, K, L, M, N, O, P,
Q, R, S, T, U, V, W, X, Y, 2);
Letter_2 : char;
begin
ShowText ;

{ Prompt the user for a letter of the alphabet. }
write('Enter a capital letter from the alphabet: ')
readln(Letter_1);
write('Again enter the same letter from the keyboard: ');
readln(Letter_2);
writeln;

{ Display the ordinal values of Letter_1l and Letter_2 .}
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writeln('Assigned value and ordinal value of first letter: ',

Letter_1l, ord(Letter_1));

writeln('Assigned value and ordinal value of second letter:',

Letter_1, ord(Letter_2));

end.

ED Text =—cr—————— gl
Enter a capital letter from the alphabet: H ﬁ
Again enter the same letter from the keyboard: H
Assigned value and ordinal value of first letter: H 7
Assigned value and ordinal value of second letter: H 72

&

var

var

Figure 3.20 Output from the program Enumerated_Type.

The subrange type is also an ordinal data type having a limited but specified
range of values. For example, after declaring the variable Month above, we might declare
other variables called Spring, Summer, Fall, and Winter:

Month : (Jan, Feb, Mar, Apr, May, Jun, Jul, Aug, Sep,

Oct, Nov, Dec);
Spring : Apr..Jun;
Summer : Jul..Sep;

Fall : Oct. .Dec;
Winter : Jan..Mar;

The declaration for the variable Spring indicates that the range of values allowed is
Apr through Jun. Attempting to declare Winter as a subrange Dec. .Mar would
cause an error message at translation time, indicating that we are trying to create a
subrange where the lower boundary Dec is greater than its upper boundary Mar. This
of course is false, since ord (Dec) is 11, while ord (Mar) is 2.

Other ordinal data types can also be used to define subranges. Here are some
examples:

Street_Number : 100..199;
Numeric_Digit : 0..9;

Uppercase_Letter : 'A'..'Z"';
Lowercase_Letter : 'a'..'z';
Character_Digit : '0'..'9';

The variable Street_Number is an integer type whose value can only be
within the range 100 to 199. During execution, an error message will appear if any
attempt is made to assign a value that is out of range. The remaining variables,
Uppercase_Letter, Lowercase_Letter, and Character_Digit, are all of
type char, with the exception that each can only be assigned an ASCII character within
its subrange. The variable Uppercase_Letter will only accept the uppercase



Constants, Variables, and Simple Input and Output  Chapter 3 95

characters A through Z. All other characters such as a through z and O through 9 are out
of range for this variable. In turn Lowercase_Letter will only accept the lowercase
characters a through z . The variable Numeric_Digit is different, since it will accept
only a single-integer digit 0 through 9. All other numbers are considered out of range.

Remember to avoid using the names of any enumerated or subrange values as
the names for other variables, for example, in the following declarations.

var
Alphabet : (A, B, C, D, E, F, G, H: I/ J/ XK, L, M, N, O, P, Ql
R, S, T, U, V, W, X,Y, Z);

J : integer;

The variable J will cause an error as the program is being translated, indicating that the
enumerated value J has already been declared at this level of the Pascal program.

3.5.4 String Types

When we want to manipulate words or phrases (rather than numbers or characters), the
appropriate data type is string . A string data type has some of the characteristics of
a simple data type and some of the characteristics of a structured data type. The proper
format for the declaration of a string variable is

identifier : string(n]

where n is an integer in the range 1-255, representing the maximum length of the
string. For example, the program called Address, listed below, with output shown
in Figure 3.21, uses the string variable to allow the user to enter and display text
material, such as a person's name and address. This program defines a series of string
variables: Name, Street, City, State, and Zip. For economy of program lines
(not memory), each of these variables is declared to have a maximum length of 80
characters, or one full line of text. The program prompts the user to enter data for each of
these variables and then displays the data in a normal address format.

program Address (input, output);
{ Purpose: examples of string data types. }
var
Name, Street, City, State, Zip: string[80];
begin
ShowText;
{ Input address data. }
writeln('Enter the requested data');
writeln;
write('Name :');
readln (Name) ;
write('Street address :');
readln(Street) ;
write('City :');
readln(City) ;
write('State :');
readln(State) ;




96 Chapter 3  Constants, Variables, and Simple Input and Output

write('Zip :');
readln(Zip);
{ Output the data. }
writeln;
writeln(' OUTPUT' ) ;
writeln;
writeln (Name) ;
writeln(Street);
write(City, ', ');
write(State, ' ', Zip)
end.

15|
I

|§DE Text
Enter the requested data

[

Name :John Doe

Street address :123 Elm St.
City :Anytown

State :US

Zip :12345

OUTPUT
John Doe

123 Elm St.
Anytown, US 12345

(=]

Figure 3.21 Output from the program Address.

3.6 TYPE DECLARATIONS

In addition to the data types already discussed, you may declare types of your own, using
the type command. This command is included in the declarations section of the
program along with const and var. The type declaration part of the program begins
with the reserved word type followed by identifiers equated to data types. Variables
declared in the variable declaration part can now be declared with these programmer-defined
types. For example, we can create new data types for some of our previously declared
variables:

type
Months_of_Year = (Jan, Feb, Mar, Apr, May, Jun, Jul, Aug,
Sep, Oct, Nov, Dec);
Weekdays = ( Sunday, Monday, Tuesday, Wednesday, Thursday,
Friday, Saturday );
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Le

Sp
Ra
De

tters = (A, B, ¢, D, E, F, G, H, I, J, K, L, M, N, O, P,
Q, R, S, T, U, V, W, X, Y, 2

ring Months = Apr..Jun;

nge = 100..199;

posit = real;

Age = integer;

var
Mo
Da
Al
Sp
St

nth : Months_of_Year;
ys_of_Week : Weekdays;
phabet : Letters;

ring : Spring_Months;
reet_Number : Range;

Weekly Deposit , Monthly Deposit : Deposit;
Age_of_Adult, Age_of_Child : Age;

Notice that in defining our own data type, we begin with an identifier name followed
by an equal sign followed by a data type. The equal sign implies that the identifier on the
left is equated with the data type on the right. As you can see by this last example, the
data type can be enumerated, ordinal, or real. In our example, the variable
Month is declared to be associated with a data type called Months_of_Year, and in
the type declaration Months_of_Year is equated with an enumerated type.
Although these types may seem to be variations on an old theme, they can be used to
make a program more readable and can also save the programmer time in declaring
variables. This concept is also important because Pascal on the Macintosh has many
different data types that can be borrowed from the libraries such as QuickDrawl,
QuickDraw2, and SANE. Appendix D provides a list of these predeclared data types.

The program shown below is a revision of our previous program called Date. The
variation in the program is the addition of three new programmer-defined data types:
Months_of_Year,Days_of_Month, and Numbers_in_Year. The latter two
datatypes are declared as subrange values.

program Second_Date (input, output);
{ Purpose: demonstrate the use of enumerated and subrange user-}

{ defined types. }
type
Months_in_ Year = (Jan, Feb, Mar, Apr, May, Jun, Jul, Aug,
Sep, Oct, Nov, Dec);
Days_of_Month = 1..31;
Numbers_in_Year = 0..99;
var
Month: Months_in_Year;
Day: Days_of_Month;
Year: Numbers_in_Year;
Slash: char;
begin
ShowText ;

{ Prompt the user for today's date. }

wri
wri
wri
wri

teln(' Enter todays date using the following ');
teln(' format: month/day/year where month');
teln(' is written as three characters, day as');
teln(' a whole number, and year as the last two');
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write(' digits of the current year: ');
readln(Month, Slash, Day, Slash, Year);
writeln;
{ Display today's date in the following format: }
{ Month - Day - 19 _ _ . }
write('Today’'s Date : ');
writeln(ord(Month) + 1 : 2, ' - ', Day : 2, ' - ', '19', Year
2);
end.

It is important to remember that data types defined under a type declaration in Pascal
are not true data objects like constants and variables. Even though these data types are
associated with names and are equated with either a real or ordinal data type, they
are not associated with values during the time the program is being translated, nor with
the storage of values as the program is executed.

3.7 THINK PASCAL VERSUS STANDARD PASCAL

There are minor differences between THINK Pascal and standard Pascal regarding simple
data types and the naming of identifiers. Standard Pascal allows the length of identifier
names to be unlimited, while THINK and Macintosh Pascal limit the length of identifier
names to 255 characters. In standard Pascal, identifier names are limited to digits and
letters of the alphabet, while THINK and Macintosh Pascal allow the underscore as one of
the characters of an identifier. When a compiler is implemented, exceptions are allowed,
since keyboards may support character sets that are different. Some systems allow both
the underscore and dollar sign ($).

How read and readln execute depends upon the implementation of the particular
Pascal compiler. For example, when reading from standard input (keyboard), pressing the
Return key may be sufficient to terminate an input line. In other instances, the readln
must be executed to force an input line to be properly terminated. In some systems, the
physical input buffer (the area of the terminal holding the characters being read on input)
may be limited to 255 bytes (characters). Attempting to execute several read statements
without executing a readln can result in the content of the input buffer being lost.
Keep in mind that these can be hardware as well as operating-system dependencies.

Not all Pascal systems require a writeln statement to terminate a line of output to
the screen. For THINK and Macintosh Pascal, a line of output is terminated if input is
read, and the character string representing an input value is terminated by pressing the
return key. In some systems, a writeln statement is important to terminate an output
line and prevent the output buffer of the terminal from exceeding a fixed length and losing
the characters it contains.

Standard Pascal only allows simple data types such as real, integer, and char
to be read using the Pascal commands readln or read, and it only allows the values of
real, integer, char, and Boolean variables to be written using the commands
write and writeln. Both Macintosh and THINK Pascal extend input and output by
allowing Pascal programs to read or write values of enumerated types. This includes
Boolean types as well as programmer-defined enumerated types such as those given
as examples in Section 3.5.3.

Both THINK and Macintosh Pascal support simple data types beyond real,
integer,Boolean, and char. These include the numeric types double,
extended, longint, and computational, and allow for large, precise floating-
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point and integer arithmetic operations. In both Macintosh and THINK Pascal, real
types are converted to extended mode when real arithmetic operations are performed.
A math coprocessor can help speed execution.

Standard Pascal does not define a string type. In standard Pascal, strings are
manipulated through the use of a packed array of characters. The concept of a string
type was first introduced in UCSD Pascal and has remained a standard type among Pascal
compilers written for personal computers such as the Macintosh. The string type
differs from a packed array of characters in that it implies the dynamic storage of strings.
A packed array of characters uses a static storage structure where all array positions in
memory are assumed to be used. While Macintosh and THINK Pascal allow character
strings to be read and written for variables declared as string types, standard Pascal can
only read character strings by continuous read operations of a single character at a time.
Both allow a packed array of characters to be written by execution of a write or
writeln command.

SUMMARY

This chapter began with a discussion of the general form of the Pascal program,
particularly the heading. We next discussed constants and variables and how we can use
them to increase the power and efficiency of the program. We then discussed the various
simple data types: four real types (real, double, extended, computational),
standard ordinal types (integer, longint, char, Boolean), and nonstandard
ordinal types (enumerated, subrange). Following the discussion of numeric data
types, we discussed the string data type, which allows the user to manipulate non-
numeric data. The final discussion was devoted to the type command, a feature of
Pascal that allows the programmer to create custom data types. Throughout the chapter,
we explored the use of the input and output commands: read, readln, write, and
writeln.

REVIEW QUESTIONS

1. What basic parts make up a Macintosh Pascal program?

2. What are the rules for naming a Macintosh Pascal program?

3. Are the following identifier names syntactically correct? Briefly explain why each
identifier name is legal or illegal.

Income Tax Program Circle_System
Inventory-System PatternMaker
1234_Program Income&Taxes

4. Are the special parameters input and output required in the program heading
of a Macintosh or THINK Pascal program?

5. What is the purpose of the uses clause? How do THINK Pascal and Macintosh
Pascal differ with respect to this command?

6. What is meant by the term library ?

7. Name the three special libraries of Macintosh Pascal. Name some of the libraries
available in THINK Pascal.

8. How are comments inserted in a Pascal program?

9. What is the last statement in a Pascal program?
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10. Is the body of a Pascal program bracketed by begin and end; or begin
and end. ?

11. Draw a diagram representing the concept of a data object.

12. Briefly explain the difference between a constant and a variable.

13. Are the following correct constant statements?

const
Constant_Value := 123.67;
Second_Value = 34.87;
Angle_One = pi;
Angle_Two = 2 * pi;
Angle_Three = Angle_One;
Truth = true
Message = 'This is a string.;

14. Is the following code syntactically correct for a Macintosh Pascal program?

const
Truth

const
Angle = pi;

const
Maximum = 9999;
Minimum = - Maximum;

true;

15. What is the logical implication of using the equal sign alone instead of := in
establishing a value for a constant identifier?

16. List the constants known by Macintosh Pascal and their values.

17. What does the reserved word var represent?

18. Are the following declarations syntactically correct?

var
Number : integer;
Total-income ; real;
LogicalValue : Boolean
Name : string;
Number : real;
Pi : integer;

19. Is the following valid in Macintosh Pascal?

_var
Person : string;
var
Income : real;
var

City_State : string;

20. Is the following program allowed in Macintosh Pascal or in THINK Pascal?
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program Example(input, output);
var
Cost_of_Item : real;
Sales_Tax : real;

const
Tax = 0.05;
begin
{ An empty example. }
end.

21. What is meant by the terms input and output ?

22. Explain the difference between the statements write and writeln.
23. Are the words write and writeln reserved words?

24. Use the Instant window to execute the following output commands:

write( 1, "+ ' , 1 ' 1is ' , 2 );

write( 2 );

writeln(2);

writeln( true, false )

writeln(true, false, maxint, maxlongint );

25. Enter and test the program titled Display_Text from Section 2.4.1.
26. Explain the difference between the commands read and readln.
27. When executed, how do the following three sets of Pascal commands differ?

write(' Enter your total income: $' );
readln( Income );

writeln(' Enter your total income: $' );
readln( Income );

write(' Enter your total income: $' );
read( Income );
writeln;

28. List the simple data types of Macintosh Pascal, and briefly explain what each
type represents.

29. What is meant by the terms floating-point number and scientific-notation ?

30. What are ordinal data types?

31. List the standard ordinal data types of Macintosh Pascal.

32. What is the range of longint and integer data types in Macintosh and
THINK Pascal? .

33. Enter and test the program Second_Counter with the declared data objects
being integer types. Test the same program with the declared data objects
being longint types.

34. What is meant by the term function ?

35. How do the functions ord, pred, and succ differ?

36. What are the nonstandard ordinal data types in Macintosh and THINK Pascal?

37. What is the difference between an enumerated type and a subrange type?

38. Show how a variable called Colors can be represented as an
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enumerated data type having the following possible values: red,
orange, blue, green, black, white, yellow, pink,
violet.

39. Declare a variable called Range_of_Income having minimum and maximum
incomes of 1000 and 9999.

40. Can a constant be an enumerated type? Can a constant be a subrange type?
Support your answers with some simple examples.

41. What is the difference between a char type and a string type?

42. Declare the following data objects as strings:

Full_Name { a string with a maximum length of 40 characters }
Street_Address { a string with a maximum length of 30 characters }
City { a string with a maximum length of 15 characters }
State { a string of length 2 characters }
Zip_Code { a string of length 11 characters }

43. What purpose does the type declaration serve in Macintosh Pascal?

44. Rewrite the declaration in Question 38 by introducing a programmer-defined data
type called Color_Chart and redeclaring the variable Colors as a type called
Color_Chart.

45. Enter and test the program shown in Figure 3.16.

PROGRAMMING EXERCISES

1. Write a Macintosh Pascal program that will perform the following steps:

(a) Prompt for an integer, and read that number.

(b) Prompt for a second integer, and read that number.

(c) Prompt for a third integer, and read that number.

(d) Compute the sum of these three numbers and assign it to Total.
(e) Display the result of the summation to the Text window.

2. Write a Macintosh Pascal program that will perform the following steps:
(a) Prompt the user for the radius of a circle, using a write statement.
(b) After entering a real number using the readln command, compute the

area of a circle using the formula

area = T * radius

where the character * represents multiplication.
(c) Output the following information to the Text window, using writeln

statements:
Radius: { value of radius }
Area of Circle: { value of area }

3. Write a Macintosh Pascal program to compute the circumference of a circle,
using the formula
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circumference = 2 * T * radius

Output the result by displaying the value of Radius and Circumference to
the Text window. This program will require write, readln, and writeln
statements.

4. The area of a triangle is specified by the following formula:
area = ( base * height )/2.0
Write a program that will perform the following steps:
(a) Prompt for the value of the base.
(b) Prompt for the value of the height.
(c) Compute the area using the given formula.

(d) Output the results of the computation to the Text window.

5. Write a program that will paint a circle in the Drawing window using the
procedure PaintCircle. This program requires the following steps:

(a) Prompt for the center of the circle:

read the X_Center;
read the Y _Center.

(b) Prompt for the radius of the circle, and read the radius.
(c) Paint the circle in the Drawing window.

6. In the metric system of measurement, 1 inch is equal to 0.0254 meters. Write a
program that prompts for distance measured in inches and computes the distance
in meters, using the constant 0.0254. Output your results with the following
writeln statement:

writeln(' Distance in meters: ', Distance:15:5 );

7. In converting Fahrenheit temperature to Celsius, we can use the following
formula:

Celsius = 5.0 * ( Fahrenheit - 32 ) / 9.0
Write a program that will prompt for the temperature in Fahrenheit and display
the temperature in Celsius degrees. Use the following writeln statement to
display this result:
writeln(' Celsius temperature: ', Celsius_Temperature : 7:2 );
Use the following checks:

212° F is equivalent to 100° C
32° F is equivalent to 0° C
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8. Write a program that will prompt for total cost of items and sales-tax rate,

compute the sales tax and the total cost (representing the sum of total cost of
items and sales tax), and display the following to the Text window:

Total cost of items: $ { value of the items }
Sales tax: { value of the sales tax }
Total cost of items: $ { value of the total cost }

9. Write a program to perform the following steps:

(a) Prompt the user for the month as a string, and read that input using the
readln command.

(b) Prompt the user for the day as a string, and read that input using the
readln command.

(c) Prompt the user for the year as a four-digit integer, and read that value using
readln.

(d) Display today's date to the Text window, using the format month/day/year.

10. Write a Macintosh Pascal program using three different string variables:

Last_Name, First_Name, and Middle_Name. Your program will require
the following steps during execution:

(a) Prompt for the first name of a person, and read this name.

(b) Prompt for the middle name of a person, and read this name.

(c) Prompt for the last name of a person, and read this name.

(d) Display the person's full name to the Text window, using the following
format:

Last name , First name (blank space) Middle name

11. Repeat Exercise 10 to display the person's full name as follows:

First name (blank space) Middle name (blank space) Last name

12. Write a program using writeln commands that will display the following

truth table:
A B Not A Aand B AorB
False False True False False
True False False False True
False True True False True
True True False True True
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13. Write a program that prompts the user for an integer, and, after reading the
number, displays the following:

pred (Number) Number succ (Number)
value of pred value of value of succ
of number number

of number

14. Write a program that prompts for the day of the week and, after the word
Sunday, Monday, Tuesday, Wednesday, Thursday, Friday, or
Saturday has been entered, displays the following to the Text window:

Day of the week: { display the value of weekday }
Predecessor of the weekday: { display pred of weekday }
Successor of the weekday: { display succ of weekday }

Define the data type called Days_of_Week, using the following
declaration:

type

Days_of_Week= ( Sunday, Monday, Tuesday, Wednesday,

Thursday, Friday, Saturday);

(Note : Some values will cause execution errors for either the predecessor or
successor functions.)



Chapter 4

Basic Arithmetic Operations,
Expressions, and Assignment
Statements

OBJECTIVES

After completing Chapter 4, you will know the following:

. The distinction between an operator and an operand in a Pascal expression.

.- Pascal operators including +, —, *, /, div, and mod.

. The nature and importance of operator precedence, including the effect of
parentheses.

. The use of the assignment statements in a Pascal program, and the meaning of the
Pascal operator :=.

. How to trace a program with the help of the Observe window.

. The Macintosh Pascal and THINK libraries of arithmetic functions, and the use of
these functions in Pascal programs.

o, H W =

4.1 THE OPERAND AND THE OPERATOR

Consider the following short program, entitled Addition:

program Addition(input, output);
{ Purpose: This program demonstrates the operation of addition. }
const
X

10;
Y 5

.
’
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var
Z : integer;
begin
ShowText ;

{ Add the values of the constants and display their results. }
Z :=X +Y;
writeln('The sum of X and Y is: ', Z : 3);

end.

This program includes the assignment statement
Z :=X+Y

where the element to the right of the colon-equal sign, X + Y, is composed of two
operands, X and Y, and the symbol + representing the operator for addition. When
executed, the operator + instructs the Macintosh computer to sum the values of the
constants X and Y . In this context the addition operator is called a binary operator,
because it requires two operands to perform the operation. This statement also contains a
second operator represented by the combined characters := . This operator represents the
assignment of a value to a variable. It is also a binary operator, since it requires two
operands during execution: the value of the expression to the right of the assignment
operator and the variable to the left. When execution of the assignment statement is
complete, the value of the expression on the right is assigned to the variable on the left.
This results in the value of the expression being stored in memory cells addressed by
variable Z. This program can be modified to do subtraction (—), multiplication (), and
division (/) by substituting the appropriate symbol (—, *, or /) for the addition operator in
the statement 2 := X + Y.

A unary operator requires only one operand. The unary arithmetic operators in Pascal
are the "unary +" and the "unary —." In the assignment statement

N :=-( B +C)

the minus sign (unary —) causes the value within the parentheses (B + C) to be
negated. That is , if the value of (B + C) is positive, - (B + C) will be negative,
and if the value of (B + C) is negative, - (B + C) will be positive. The operator
unary + is referred to as an identity operation. This means that it leaves the value
unchanged when applied as a unary operator. For example, the value of the expression +
(B + C) is the same as the value of (B + C). Both binary and unary operations for
Macintosh and THINK Pascal are listed in Figure 4.1.
Notice that expressions such as

+

B + C
)
)
)

+ +
nnoa~

B +
B +
B +

—_~ e~~~
+ |
—~ e~~~

are syntactically valid, while expressions such as
-+ B+ C)
+ - B+ C)

(
(
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Q0

+ -
+

Wwww~—~
+ 4+ + + Ww
N0 O+ +

are invalid. Combinations of operator symbols suchas - - , - + , + + , + - are
not recognized as valid unary operations. In general, the best rule is to follow each unary
operator with a set of parentheses placed around the expression that the unary operator is
acting on. This helps to avoid errors whenever expressions are either typed or checked.

Although many of the Macintosh and THINK Pascal arithmetic operators are rep-
resented by single-character symbols, two special arithmetic operators require short
syllables: div and mod. The use of div and mod requires sensitivity to the use of
data types when constructing expressions, since they are "integer-only" operators: they
require operands that can only be integer data types. With some arithmetic operators,
the mixing of values for integer and real variables can produce either real or
extended results. In standard Pascal, however, div and mod produce only integer
results.

Unary Operators
(signs)
Operator Operation Operand types
+ Identity Integer or real?
- Sign negation Integer orreal?

Binary Operators

Operator Operation Operand types
+ Addition Integer or reallb
- Subtraction Integer or realb
* Multiplication Integer orrealb
/ Division Integer orreal
div Division with integers Integer
mod Modulo Integer

2 The result is real if the operand type is real, and integer if the operand type is
integer.

b The result is real if both operand types are real or if one is real and the other is
integer.

Figure 4.1 The unary and binary arithmetic operators.

How do the three arithmetic operators / , div , and mod differ? We use the operator
div when both operands are integer types, and when the result to be computed is the
quotient of one integer value divided by another integer value. The mod operator,
a division operator, yields as a result the remainder of one integer value divided by
another integer value. For example, 5 mod 2 yields a result of 1 (5 divided by 2
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yields 2 with a remainder of 1). The division operator, /, is different: it results in a real
value whether the operands are of integer, real, or mixed data types.

As an example, look at the Text window shown in Figure 4.2 . In this example we
have selected the Instant window from the menu option Windows (Debug for
THINK Pascal),! and typed three writeln statements to test the differences among the
three binary division operators.

& File Edit Search Run Windows

[E[J==——=—=—= Instant

writeln(* Integer division : ', 8 div 6);
writeln(' Real division: ', 8/ 6);
writeln(* Integer remainder: ', 8 mod 6);

Text
Integer division : 1
Real division: 1.3e+0
Integer remainder: 2

Figure 4.2 Application of the Instant window in Macintosh Pascal.

Note that the Program and Drawing windows can be either opened or closed. We have
elected to close these windows. After typing all three statements, use the option Check
to check for any syntax errors. If any text exists in the Text window, choosing the option
Reset from the menu option Run will clear the window. To execute any of the
statements that are in the Instant window, click the Do It button. In this case the three
separate statements are checked and then executed, so that three separate lines of text are
displayed in the Text window. For the integer constant 8 divided by integer
constant 6, the first line of text gives the value of the quotient, the second gives the result
for real division in terms of a floating-point value representing 1.333333.. ( a
combination of the quotient as a whole number and the remainder as a fraction), and the
third line displays the remainder. Notice that both the integer division operators div
and mod give integer results.

Lyf you do this exercise with THINK Pascal, you will discover that the Instant window is active
only when a program has been executed and halted. You may achieve this state by opening a
project, executing the 60 command, and then halting execution by clicking the spray-can
icon. If your program executes too quickly to allow this, you may insert one or more stops
to halt execution. The statements you test in the Instant window need not be related to the
program whose execution you halt.
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As a second example of using the div operator, consider an example Pascal
program designed for computing the percentage of partisan votes in an election. When
executed, this program prompts the user to enter the number of votes for Democratic
candidates and the number of votes for Republican candidates, and then it computes the
total partisan vote, the percentage of Democratic votes, and the percentage of Republican
votes. All percentages are to be stored as whole numbers. After all computations have
been performed, the total number of votes and the percentages are displayed to the Text
window.

Here is the algorithm for developing this program:

Algorithm Election;

{ This algorithm computes the percentage of Democratic and
Republican votes in a partisan election. }

{ List of data types:

Democrats, Republicans, Total_Votes : integer
Percent_Democrats, Percent_Republicans : integer }
begin

{ Prompt user for Democratic and Republican votes. }
write 'Enter the number of Democratic votes: ' ;
read Democrats ;
write 'Enter the number of Republican votes: ' ;
read Republicans ;

{ Compute the total number of votes and the percentages. }
Total_Votes <-- Democrats + Republicans;
Percent_Democrats <-- ( Democrats * 100 ) div Total_Votes;
Percent_Republicans <-- ( Republicans * 100 ) div Total_Votes;

{ Display total votes and the percentages. }
write Total_Votes ;
write Percent_Democrats ;
write Percent_Republicans ;

end.

The Pascal program for algorithm Election follows. Here we have added
writeln statements to help when displaying output. In addition, the constant 100 has
been replaced with an identifier called Base.

program Election(input, output);
{ Purpose: A demonstration of the operator div. This program }

{ computes and displays the percentage of Democratic }
{ and Republican votes in a partisan election.}
const
Base = 100;
var
Democrats, Republicans, Total_Votes : integer;
Percent_Democrats, Percent_Republicans : integer;
begin
ShowText;
{ Prompt user for Democratic and Republican votes. }
write( 'Enter the number of Democratic votes: ');

readln( Democrats);
write( 'Enter the number of Republican votes: ');
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readln( Republicans) ;
{ Compute the total number of votes and the percentages. }

Total_Votes := Democrats + Republicans;
Percent_Democrats := ( Democrats * Base ) div Total_Votes;
Percent_Republicans := (Republicans * Base) div Total_Votes;

{ Display total votes and the percentages. }
write('A total of ', Total_Votes : 2 );
writeln(' votes were cast in this election');

writeln;
write(' The Democrats received ', Percent_Democrats : 2 );
writeln(' percent of the vote.');
writeln;
write(' The Republicans received ', Percent_Republicans : 2 );
writeln(' percent of the vote.');

end.

If you want slightly greater precision, use the real division operator, /, to produce
real (decimal) results. This would require that the variables Percent_Democrats
and Percent_Republicans be declared as type real instead of integer. Why? A
syntax rule in Pascal is that a variable of type integer cannot be assigned a value of an
expression of type real.

The program Election_Revised shows the changes necessary to produce
percentages with decimal-fraction precision.

program Election_Revised(input, output);
{ Purpose: A demonstration of the operator div. This program }

{ computes and displays the percentage of Democratic }
{ and Republican votes in a partisan election.}
const
Base = 100;
var
Democrats, Republicans, Total_Votes : integer;
Percent_Democrats, Percent_Republicans : real;
begin
ShowText ;

{ Prompt user for Democratic and Republican votes. }
write( 'Enter the number of Democratic votes: ');
readln( Democrats);
write( 'Enter the number of Republican votes: ');
readln( Republicans) ;
{ Compute the total number of votes and the percentages. }
Total_Votes := Democrats + Republicans;
Percent_Democrats := ( Democrats * Base ) / Total_Votes;
Percent_Republicans := ( Republicans * Base ) / Total_Votes;
{ Display total votes and the percentages. }
write('A total of ', Total_Votes : 2 );
writeln( ' votes were cast in this election');
writeln;
write(' The Democrats received ', Percent_Democrats : 5 : 2 );
writeln(' percent of the vote.');
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writeln;
write(' Republicans received ', Percent_Republicans : 5 : 2 );
writeln(' percent of the vote.');

end .

The only difference between Election and Election_Revised is in the way
the percentages are computed and displayed. Election displays percentages as whole
numbers, whereas Election_Revised displays percentages in a decimal format with
a field of five characters and two digits to the right of the decimal point.

Modulo, or mod, is an integer division operation that gives as a result the
remainder of an integer division process. It is important to understand that special
conditions apply when using this operator:

1. If M is not zero, Nmod M is equivalent toN - (N div M) * M.

2. In THINK Pascal, N mod M results in an executable error if the value
of M is zero.

3. In standard Pascal and in Macintosh Pascal, N mod M is in error if M
is either zero or negative.

4. When N is negative and M is greater than 0, the mod operation in
Macintosh Pascal is not consistent with THINK Pascal. The mod
operation in Macintosh Pascal is only consistent when N is greater than
or equal to 0, and M is greater than 0.

Here N and M are assumed to be integer types. The following program, Modulo_
Demonstration, illustrates the use of the mod operator. The statement

Remainder := Dividend mod Divisor;

is assumed to produce an integer remainder for any two integers entered from the
keyboard, one represented by the variable Dividend and the other by the variable
Divisor. This program is useful for demonstrating the results of the three conditions
just described. The modulo operator has some interesting applications, several of which
are shown in Chapters 5 and 6.

program Modulo_Demonstration(input, output);

{ Purpose: This program demonstrates the operator mod. }
var

Dividend, Divisor, Remainder : integer;
begin
ShowText ;

{ Prompt user to enter two numbers. }
writeln('Enter a number as a dividend: ');
readln(Dividend) ;
writeln;
writeln('Enter a number as a divisor: ');
readln(Divisor) ;

writeln;
{ Perform the mod computation and display the result. }
Remainder := Dividend mod Divisor;

7

writeln(Remainder : 2, ' is the remainder of ', Dividend : 2);
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writeln(' divided by ', Divisor : 2, ' . ');
end .

4.2 OPERATOR PRECEDENCE

The order in which arithmetic operations are performed is called precedence. In Chapter 3
we pointed out the need for precision and lack of ambiguity in writing an algorithm. To
achieve this, we must be able to evaluate an expression in an unambiguous manner. For
example, there must be one and only one answer to evaluating the following expression:

B+ C * D.

Rules of precedence for arithmetic operators are summarized in Figure 4.3. In
Macintosh and THINK Pascal, the unary operators + and — have equal operator precedence
with addition and subtraction.

Operators 2 Level of
Precedence
* ,/ ,div,modP? (highest)
+,-¢ ﬂiwest)
2 Precedence rules for all operators in Macintosh and THINK Pascal are given in
Figure5.5.
b The multiplication and division operators have equal precedence among
themselves.
¢ The addition and subtraction operators have equal precedence among
themselves.

Figure 4.3 Precedence rules of arithmetic operators in Pascal.

Performing addition followed by multiplication could result in entirely different results
from performing multiplication followed by addition. The rules of precedence are meant to
eliminate this ambiguity. These rules require an expression to be evaluated in an order
determined by the precedence of the operators involved in the expression. Otherwise,
execution of operators of the same level of precedence and the operands to which they are
bound is from left to right. Some of these rules are demonstrated in the program
Precedence.

program Precedence(input, output);
{ Purpose: Demonstrates the order of precedence in the }

{ evaluation of an expression. }
var
A,B,C,D : integer;
begin
ShowText ;
{ Assign values to the variables B, C, and D. }
B :=5;
C := 10;
D := 2;

{ Evaluate the expression and display the results. }
A :=B + C * D;
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writeln('The expression 5 + 10 * 2 is evaluated as: ', A : 1);
end.

With the operand B assigned the value 5, C assigned the value 10, and D assigned the
value 2, the value computed and assigned to A is 25 according to the rules of precedence
given in Figure 4.3. Since the multiplication operator (*) has a higher precedence than the
addition operator (+), the multiplication operator (*) is executed first.

However, if we substitute the expression

A :=B/ C*D;

for the expression given in Precedence, the results will change. The multiplication
operator (%) and the division operator (/) have the same level of precedence, so execution
is performed from left to right. In this example, the division is performed before the
multiplication. If we assign the same values to the variables B, C, and D as before, the
value of the expression B / C * D becomes 1.0. However, before we can execute this
revised program, we must make the following change:

var
A : real;
B, C, D : integer;

This change is required because the division operation is real rather than integer.
Without this change, the program will produce an error message informing you of an
incompatibility of types.

Parentheses can be used to alter the order in which operations are performed in an
expression. In the statement

the variable A becomes 25 when the constants B, C, and D are defined as 5, 10, and 2, as
in the program Precedence. We can change the order in which these operations are
performed by using parentheses as follows:

A :=(B+ C) * D;

Now when the expression is evaluated, the value of A becomes 30, because the operation
within parentheses is executed before operations outside the parentheses.

Expressions can be nested within parentheses as long as the parentheses are balanced,
that is, paired. For example, the statement

A:=B- (C* (D+F));

results in the addition operation (+) being executed first, the multiplication operation (*)
next, and the subtraction (=) operation last. The rule when using parentheses is that the
expression contained in the innermost pair is evaluated first. Then the expression
contained within the next level of parentheses is evaluated, and so forth, until execution is
complete. Execution of the program Parentheses demonstrates that under these
circumstances, A is evaluated as —45.
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program Parentheses (input, output);
{ Purpose: This program demonstrates the effect of parentheses }

{ on operator precedence. }
var

A,B,C,D,F : integer;

begin

{ Assign values to the variables A through F. }
B :=5;
C := 10;
D := 2;
F := 3;

{ Evaluation of the expression and display of the result. }
A :=B -(C* (D+F));
writeln('A = ', A : 1);

end.

4.3 EXPRESSIONS AND THE ASSIGNMENT STATEMENT
The construction of a valid statement is based on two primary rules:
1. Valid statements have one and only one variable on the left side of the
statement.
2. No operators may be on the left side of the statement.
For example, the statement

X +Y :=12 + Z

is invalid because it violates both of these rules: two variables, X and Y, and the operator
+ are found on the left side. To make this a valid statement, we must show only one
variable on the left, as in the following:
X :=12 + 2
An assignment statement has the basic form of
Variable := expression ;
where expression may be any of the following:
1. A variable
2. A numeric constant

3. expression operator expression

For example, all of the following are valid assignment statements:



116 Chapter 4  Basic Arithmetic Operations

3

R
e
KR

* 8

The := denotes that the data object on the left side of the statement, called a variable,
is assigned a value obtained from executing the expression. This allows statements such
as

X := X+ 1;

In Pascal, the statement X = X + 1, where = is read as "is equal to," is illogical.
Equality implies balance in value for both sides of an equation. The statement X := X
+ 1 does not express balance. Rather, the value of 1 is added to the value of X when the
expression on the right side of the statement is executed. The resultant value is then
assigned to the variable X on the left side of the assignment operator (:=).

Notice that a statement such as X = 13 represents an expression of equality and is
used to establish the value of X as a constant. Such expressions are found in the constant
declarations of a Pascal program, under the const heading. The program Con-
version illustrates these points.

program Conversion(input, output);
{ Purpose: This program converts a Celsius temperature, entered }

{ by the user, into a Fahrenheit temperature. The }
{ result is displayed on the screen. }
const
K = 32;
var
Celsius, Fahrenheit : integer;
begin

{ Prompt the user to enter the Celsius temperature. }
write('Please enter a Celsius temperature: ');
readln(Celsius);

{ Convert Celsius temperature to Fahrenheit temperature. }
Fahrenheit := ((Celsius * 9) div 5 + K);

{ Display the results.}
writeln('The Fahrenheit equivalent is: ', Fahrenheit : 2);
writeln;

end .

This program illustrates the use of both = and := in assigning values to data objects.
The constant used in the conversion of a Celsius temperature to a Fahrenheit temperature
is 32. Thus the constant K is declared and its value equated with 32. This statement uses
the =, since an equality is being established.

const
K = 32;

Later in the program the actual conversion is accomplished in the following statement:
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Fahrenheit := ((Celsius * 9) div 5 + K);

The result is integer, since Fahrenheit is declared as an integer type, but
the program can compute real values by replacing div with / and by declaring both
Celsius and Fahrenheit tobe real .

As an added example, let us develop both an algorithm and a program for reversing
the digits of an integer number. Assume that we want a program to prompt the user
for a four-digit integer number and, after this number has been entered, display the
digits in reverse order. For example, the user would enter a number such as 9753, and the
program would display the value 3579 . In writing both the program and the algorithm,
let us make some basic assumptions:

1. We assume that our initial number is represented by the digits dd,dsd;.
The new number will be represented by the digits dydsdyd, .

2. Our initial number must always be positive.

3. All individual digits must be between 1 and 9; 0 is not allowed.

The following steps represent an initial solution:

1. Read a four-digit integer number entered from the keyboard.
2. Extract each of the four digits from the initial number.

3. Create a new number from the four separate digits.

4. Write the value of the new number.

The second and third steps are ambiguous and must be refined. For the second step, let us
assume that our digits will have unique names: Digit_1,Digit_2,Digit_3, and
Digit_4. To obtain the leftmost digit, we need only compute the following step:

Digit_1 <-- Initial_Number div 1000

To compute the second digit from the left, we remove the first digit on the left by using
one of two statements:

Remainder <-- Initial_Number mod 1000
or
Remainder <-- Initial_Number - ( Digit_1 * 1000 )

We will choose the former and leave the latter as an exercise. The result is a
remainder representing a new number having only three digits: dyd3d,.

Next we extract the remaining digits by repeating the same steps but with
Initial_Number replaced by Remainder. The following is a refinement of our
initial algorithm:

Algorithm Reverse_Digits;

{ Reverse_Digits reverses the digits of a four-digit integer
number. }

{ List of wvariables:
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Initial_Number, New_Number, Remainder : integer
Digit_1, Digit_2, Digit_3, Digit_4 : integer }
begin
{ Enter a four-digit integer number from the keyboard. }
write 'Type a four-digit integer number: ';
read Initial_Number;
{ Extract each of the four digits from number. }
Digit_1 <-- Initial_Number div 1000;
Remainder <-- Initial_Number mod 1000;
Digit_2 <-- Remainder div 100;
Remainder <-- Remainder mod 100;
Digit_3 <-- Remainder div 10;
Digit_4 <-- Remainder mod 10;
{ Create the new four-digit number. }
New_Number <-- (Digit_4 * 1000) + (Digit_3 * 100) +
(Digit_2 * 10) + Digit_1;
{ Display the value of our new number. }
write New_Number
end.

To test our newly defined algorithm and see if it is functional, we can trace its steps by
establishing a trace table, as shown in Figure 4.4. At the top of the table is a list of
variables, and to the left is a simple counter called Step. Each time a step is evaluated,
we record the changes to any of the values of variables. (Figure 4.6 presents the Pascal
program, but without comments.)

tep Initial_  Digit_1 Digit_2 Digit_3  Digit_4 Remainder New_
Number &

Number
1 8642
2 8
3 642
4 6
5 42
6 4
7 2
8 2 2468

Figure 4.4 Trace table for the algorithm Reverse_Digits.

In writing an assignment statement, we must always consider the issue of compatibility
between the data types of an expression and a variable. In Macintosh Pascal, data-type
compatibility is checked when the program is executing, not at the time of translation.
Thus you will not find assignment-compatibility errors by choosing the option Check
from the Run menu. Figure 4.5 shows a list of rules for all of the data types discussed in
Chapter 2. The typical error message for assignment compatibility is "An incompatibility
between types has been found." Understand that Pascal does not allow an integer
variable to be assigned a real value. Any attempt to use such an assignment statement
will produce a syntax error.
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For an assignment statement of the form variable:=
expression, the value of the data type for expression is
assignment-compatible with the data type of variable if any
of the following is true:

1. Variable and expression are identically declared types.

2. Variable and expression are real types, and the value of
expression is within the range of possible values for variable.

. Variable is is a real type, and expression is an integer type.

. Variable and expression are compatible ordinal types, with
the value of expression being within the range of possible
values for variable.

5. Variable is a char type and the value of expression is a string

type having a length of 1.

6. Variable isa string type with a maximum size of n
characters, and the value of expression isa string type
having a length less than or equal ton .

7. Variable is a string type, and expression is a char type.

> W

Figure 4.5 Assignment compatibility rules for Macintosh and THINK
Pascal.

4.4 USING THE OBSERVE WINDOW TO TRACE A PROGRAM

The use of trace tables in testing an algorithm can be supplemented in Macintosh Pascal
by use of the Observe window. Figure 4.6 shows our example of Reversed_Digits,
which uses the Observe window to monitor the value of the variable Remainder. This
window is primarily helpful in tracing values of intermediate variables and expressions.
That is, variables such as Remainder contribute to generating the output of a program
but are not themselves displayed as output. This is particularly important with respect to
the values, variables, and expressions that affect the Drawing window.

To use the Observe window, open the Program window and select Stops In from
the Run menu. Next, place = stop to the left of the program line after the last line you
want to execute. In Figure 4.6 we placed a stop after the two statements for the variable
Remainder by moving the cursor into the zone to the left of the program line, and then
clicking the mouse button. After the stops are placed, open the Observe window from the
Windows menu.2 In Figure 4.6 we typed the word Remainder to the right of the
prompt Enter an expression. After you press the Return key, the prompt Enter
an expression appears, and the system waits for the next expression. When you
have entered all expressions, open all windows necessary for observation. As Figure 4.7
shows, we only require that the Text window be opened for observing the prompt and for
entering a four-digit integer number. Then select either the option 60 or 60-60 from
the Run menu. When the program reaches a stop sign, it updates the boxes to the left of
the expressions in the Observe window. Figure 4.7 shows the value for Remainder
after the program encounters the first stop sign. The program will continue to execute if

2 The Observe window is located under the Debug menu in THINK Pascal.
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Go-G6o was selected. Otherwise, select GO or 60-60 to continue execution. By using the
Observe window, you can see a real-time display of the intermediate values for
expressions or variables that control output but are not normally visible as part of the
output. This can be an important tool for debugging.

Reverse_Digits

:

program Reverse_Digits(input, output);
{ Purpose: This algorithm reverses the digits of a four- }
{ digit integer number . }
{ List of variables }
var
Initial_Number, New_Number, Remainder: integer;
Digit_1, Digit_2, Digit_3, Digit_4: integer; Text

begin
ShowText; Type a four digit integer n

{ Enter a four-digit integer number from the keyboard.
writeIn('Type a four-digit integer number: '); 4321
readin(Initial_Number); Am—] _—

{ Extract each of the four digits from number. }I=|:| Observe ===
Digit_1 := Initial_Number div 1000; 0 |Digit_2